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Basics

Service Pack 2 2017 (V 2202)

Changed licensing
n The functions for drawing derivations is now generally available and not, as in previous versions, only in con-

junction with the HiCAD Sheet Metal professional.

n The minimum requirement for the HiCAD Metal Engineering module is now HiCAD creator + HiCAD Beam-
s+Profiles.

n The minimum requirement for the HiCAD Steel/Metal Engineering module is now HiCAD creator.

n The HiCAD Plant Engineering suite premium now also contains the modules Steel Engineering and Stairs +
Railings. This allows you to configure staircases and railings create complex beam structures and use smart
connections.

HiCAD VI/AV

The New drawing function is now no longer locked in the VI/AV mode. This allows a loading KRA files in the
VI/AVmode via Drawing > Insert Part > ....

KNTPAR.DAT -> Configuration Editor
In previous versions the settings for the graphical representation of 3-D edges and surfaces were specified in the
system file KNTPAR.DAT. From HiCAD 2017 SP2 onwards this file is no longer available. Its setting options have
beenmoved to the Configuration Editor at System settings > Visualisation > 3-D.

HiCAD Education Edition
n Drawing files (.SZA) and part files (.KRA) saved with the HiCAD Education Edition cannot be read by the HiCAD

Standard Edition. If you attempt to open such files with the HiCAD Standard Edition, the following message will
be displayed.

n In the title bar of the HiCAD UI the note HiCAD Education Edition: Not for commercial use will be shown.
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n The plot stamp will be omitted on printouts.
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Opening of HiCAD documents from opened HELiOS dialogues
You can now directly load HiCAD documents into HiCAD that have been opened in HELiOS dialogues within HiCAD.
Opened HELiOS dialogues are automatically closed, and actions blocking the process will be cancelled, so that the
opening of the documents can take place.
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New test options in the Design Checker
The Steel Engineering checks

n Max. dimensions and weight of assemblies and

n Max. length and weight of beams

have been enhanced.

You have now the option to perform the check depending on the usage of assemblies or on the beam types. For this
purpose the setting options in the Configuration Editor have been expanded accordingly:

Clicking the symbol opens a dialogue window, where you can enter the desiredmaximum values, e.g.:
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Enhanced display of keyboard layout in the UserInterfaceEditor
In the Shortcuts dialogue window of the UserInterfaceEditor (see also Customizing the User Interface), the System
shortcuts are now displayed, in addition to the User-defrined shortcuts.

The system shortcuts cannot be changed!
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New 'Part variables' docking window
A new docking window for part variables is now available. In this docking windows the part variables of the active
part and (if any) also those of the superordinate parts are displayed.

The symbols in front of the Part variables indicate the type of the variable.

With the functions of the docking window you can

n add new variables,

n change values of variables and comments, and

n delete variables.

To show the docking window, choose Settings > Docking windows and activate the Part variables entry in the
sub-menu.
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Service Pack 1 2017 (V 2201)

Further extension of product range
n The new Element Installationmodule allows an utilisation of individually parameterized elements as installation

elements or inserts.

n A new Standard Parts package for ALUCOBOND® tray panels is now available.

n Four new HiCAD suites are now available:

HiCAD ALUCOBOND®
exclusive Standard

HiCAD ALUCOBOND®
exclusive Premium

HiCAD
ALUCOBOND®
hybrid Standard

HiCAD
ALUCOBOND®
hybrid Premium

n Sheet Metal suite

n Beams + Profiles
module

n Element Installation
module (without cus-
tomer-specific tray
panels)

n ALUCOBOND® tray
panels

n Report Manager pro-
fessional

n Sheet Metal suite
premium

n Beams + Profiles
module

n Element Installation
module (without cus-
tomer-specific tray
panels)

n ALUCOBOND® tray
panels

n Report Manager pro-
fessional

n Sheet Metal
suite

n Beams + Pro-
files module

n Element Install-
ationmodule

n ALUCOBOND®
tray panels

n Customer-spe-
cific tray panels

n Report Man-
ager pro-
fessional

n Metal Engin-
eering suite

n Sheet Metal pro-
fessional mod-
ule

n Element Install-
ationmodule

n ALUCOBOND®
tray panels

n Customer-spe-
cific tray panels

ALUCOBOND tray panel SZ-20 and ALCUBOND suspended
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Parameter Configuration with security prompt
When you close the HiCAD Parameter configuration dialogue window with OK, the following message will appear:

If you confirm this message with OK certain system files in the HiCAD sys and szenen directory will be replaced by
files supplied in the templates directory, which are adjusted to the selected module and the activated checkboxes
(e.g. DSTV or Management + BIM). These could be, for example:

n HiCAD masks for part attributes (*.HDX)

n HELiOS masks for projects, documents and articles (*.MSK)

n several configuration files (*.HDB)

n template files for designation (*FTD) and

n drawing frames with adjusted title block.

Therefore you should save all files which you have individually modified or contact your ISD branch.

The operation can be closed without a change of configuration by selecting Cancel.
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Extended options for saving of parts
Parts and processings from the Element / Profile installation can now be saved, with the help of the Reference

Part, Save, Detail drawing function, to the corresponding catalogues beneath Installation planning - Parts
and Processings.
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Enhanced information for 3-D lines

The Line function at Information > 3-D, Further... has been enhanced. Layer, colour and line type of the
selected line are now also displayed in the dialogue, e.g.:

Extended Selection

The dialogue of the Extended selection function has been improved.
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Enhanced Design Checker
The Design Checker now offers the additional option to check which part(s) of your model drawing are BOM-rel-
evant but have no article master. Standard parts (incl. standard beams and profiles) will not be considered in the pro-
cess.

Preview for point options
For certain point options, for which user entries are required, no preview will be displayed. This applies e.g. to the
insertion and transformation of parts for the point options with value input, like
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n R - Relative cooridantes

n D - Distance from start of line/edge

n P - Absolute angle and distance

as well as options for succeeding points

n M2 -Midpoint between two points

n FL - Perpendicular Point -> Line/Edge
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Major Release 2017 (V 2200)

New file format for 2-D files
Similar to the .KRA files in 3-D, figure archive files also exist for 2-D with the file name extension .FGA. These con-
tain the previous 2-D data (.FIG), the DB attributes (.FIG.DBA2) as well as the attribute container data (.FIG.ATC)
and thus replace the previous 2-D files. Furthermore, the new .FGA format allows a displaying of the 2-D files in a
Viewer and contains the 2-D HCM data.

Please use only the new .FGA format! For the conversion of existing 2-D FIG files you can use the Con-
verter_FIG_To_FGA.exe tool in the HiCAD\exe directory. You can also install this converter form the
installation DVD.

When you perform an update to HiCAD 2017, the 2-D parts that are supplied with HiCAD by default (e.g.
drawing frames) will be switched from FIG to FGA in different locations of the installation directory.
Before their conversion, the data are saved in their original state in a folder or ZIP archive, respectively, to
the "Szenen" and "Kataloge" directories. A LOG file in each directory records all converted files.

When you create an interface between HiCAD 2017 and HELiOS you will be prompted after a new or an
update installation to adjust the database accordingly. The search for andmanagement of 2-D parts will
only be possible after a successful adjustment of the database and the conversion of the existing FIG
files.

Please also read the information given in the Installation Notes!

Revised "Drawing" tab
n The detail drawing functions for marked Steel Engineering parts can now be found at Drawing > Itemisa-

tion/Detailing > Derive... > Detail drawing... .

n At Drawing > Itemisation/Detailing > Attr... you will now find the following functions:

Part annotation templates

Templates, Attribute assignment

Article master, Itemisation

Document master, Detail drawing

n You can now find this function via Drawing > Itemisation/Detailling > Dim...

Edit dimensioning rules

Dimensioning Settings

These functions were previously found at Steel Engineering > Further functions > Settings > ....
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Access to BIMcatalogs.net by CADENAS

Access to 3-D BIM CAD models has been made even more comfortable. You can now use the BIMcatalogs

function (Drawing > Insert Part > Exp >...) to access 3-D BIM CAD models in the product catalogue BIM cata-
logs.net by CADENAS. The 3-D BIM CAD models can be imported rapidly and easily to HiCAD by Drag & Drop,
where can they processed further.

This easy way of access spares you a lot of time that would otherwise be spent on searching for the right model,
and increases the productivity of your Engineering department.
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Article number configuration for assemblies
When creating new assemblies, forming assemblies from existing parts and automatically creating assemblies (e.g.
for Steel Engineering), the prefix Assembly will be suggested as the default value for the article number. This setting
can now be changed in the Configuration Editor at Steel Engineering > Assembly.

The ISD default setting is the text stored in the HiCAD text key TEXTE_STB325 , i.e. the string "Assembly".

If you want to use your own text instead, simply enter it into the field after deactivating the Text key checkbox.

This setting cannot be applied to main assemblies.

Faster build-up of part structure in the ICN 
The development of the part structure in the ICN has been accelerated noticeably. This affects in particular large
drawings, e.g. after updating a connection in Steel Engineering.

Absolute / relative point options- facilitated entry
Relative coordinates / relative angles

If no reference point is used for point options R, Relative Coordinates, and Relative Angle W / WX / WY, you can
enter the coordinates – or angles and lenghts – all in one step separated by spaces.

If an exact reference point or reference line was to be used (i.e. after activating the point options you immediately
pressed the left mouse button or the RETURN key), previously you had to enter each value separately and confirm
each value with ‘OK’. This procedure has now changed and thus allows you to enter the coordinates – or angles and
lengths – all in one step separated by spaces.
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Absolute angles

You can also enter angles and lengths in one step - separated by spaces - for the Absolute Angle + Distance P, PX,
PY point options.

Point options when sketching
When the sketching function is activated, e.g. when creating a 2-D sketch or a plane sketch in 3-D, for a numeric
point option (A, D, K, N, P, R, W) the keys now open the menu for the entry of point options automatically. The dis-
tance menu will only be displayed via the spacebar.

Redraw body - removed from Data structure menu
The Redraw body, Active part function and Redraw body, All parts function are no longer available in the Data
structure menu and can only be accessed via the

n 3dinfo_krpneuaufbau1.mac) (only active part) or

n 3dinfo_krpneuaufnau2.mac)(entire drawing)

macros. The macros can be found in the MAKROS3D directory in the HiCAD installation. The macro call is effected
via CTRL+8.

As of HiCAD 2018 these functions (macros) will no longer be available. If you know of concrete problems
which still needmacros to be resolved please contact the Hotline immediately in order for these problems
to be taken into consideration in the cutoff.

When selecting the macros mentioned above the following message will appear:

If the message shall not be displayed in active HiCAD sessions you can activate the corresponding checkbox.
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Enhanced Save part function
Part from the Profile Installation area can now be saved to designated catalogues under Profile Installation + Parts

and Processings via the Reference Part, Save, Detail drawing function
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Modified default settings for drawing derivation

In the Configuration Editor the settings for Production drawing have been modified - depending on the parameter
configuration.

Path Parameter old new *1 new *2

Production drawing > Drawing Leave external draw-
ing open

Close
drawing

Close
drawing

Leave drawing
open, switch to ori-
ginal drawing

Production drawing > Drawing Centre individual
view group

Production drawing > Drawing >
Drawing frames

Frame height
/ Frame width

0 / 0 410 /
584

410 / 584

Production drawing > Annotations
> Grid annotations

Grid annotation:
Line type of axis

1 5 5

Grid sub-system
annotation: Line
type of axis

1 5 5

Production drawing > Annotations
> Grid annotations > Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Annotations
> Grid annotations > Sub-system,
Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Devel-
opment

Dimension bend
lines

*1 Default template: Steel Engineering / Metal Engineering / Management + BIM

*2 Default template: Mechanical / Plant Engineering as well as user-defined template: ISD Default
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Service Pack 1 2017 (V 2201)

GRAPAR.DAT settings moved to Configuration Editor
In previous versions, the size of isolated points could be specified in the GRAPAR.DAT file. As of HiCAD 2017 SP1
this file will no longer be available. Its setting options have been moved to the Configuration Editor at System set-
tings > 2-D Lines > Enlargement factor: Isolated points and Enlargement factor for assembly points, respect-
ively.
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New file format for 2-D files
Similar to the .KRA files in 3-D, figure archive files also exist for 2-D with the file name extension .FGA. These con-
tain the previous 2-D data (.FIG), the DB attributes (.FIG.DBA2) as well as the attribute container data (.FIG.ATC)
and thus replace the previous 2-D files. Furthermore, the new .FGA format allows a displaying of the 2-D files in a
Viewer and contains the 2-D HCM data.

HiCAD 2017 comes with the new 2-D figures archive with the file name extension .FGA. Please use
only this new .FGA format for conversion of existing 2-D .FIG files! For this purpose, use the new Con-
verter_FIG_To_FGA.exe tool in the HiCAD\exe directory.

When you update to HiCAD 2017, the 2-D parts that are supplied with HiCAD by default (e.g. drawing
frames) will be converted from FIG to FGA in various folders in the installation directory. Before their con-
version, the data will be saved in their original state in a folder or ZIP file, respectively, to the "Szenen"
and "Catalogue" directory. Also, a LOG file recording the conversion will be saved to both directories.

Please also read the information given in the Installation Notes!

Variable dimensionings

The Individual dimension, Variable menu combines a multitude of individual dimensioning functions. It
allows a rapid creation of

n axially parallel and free linear dimensions,

n angular dimensions,

n arc dimensions and

n circle, radius and diameter dimensions

with only one function. Depending on the selected element, e.g. line, circle or point, the correct dimensions will be
immediately created here or - if different dimensions are possible - a selection option will be displayed.

The individual dimensions for lines, angles arcs and circles can now be found in one menu.
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Renamed function tooltips
In the Surface/Tolerances function groups the tooltips of the following functions have been changed as follows:

Old New

New symbol Form/Positional tolerances

Characters Insert symbol

Symbols Surface characters+symbols

Point options during sketching
If the sketching mode is active, e.g. during drawing of a 2-D sketch or a planar sketch in 3-D, the corresponding
point option dialogue window will always be opened when you press a key for a numerical point option (A, D, K, N,
P, R, W). The Distance input menu instead of the point option dialogue will now only be displayed when you press
the space bar.
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3-D

Service Pack 2 2017 (V 2202)

Model / process parts

Deform - New 'Local' option

The Deform allows a bending, twisting, tapering and stretching of 3-D parts along an existing sketch. The
sketch plane determines the neutral axis for the deforming process. This means that the part area to be deformed is
determined by the planes that run perpendicular to the start point and end point of the sketch. In previous versions,
the complete area of the part that was located between these two planes was deformed.

From SP2 onwards you have also the option to perform local deformations. In the vicinity of the corresponding axis
it will be attempted to select the smallest possible area from all the areas/connected elements of the part that are
located between the two planes, and apply the deformation only there.

For this purpose the new Local checkbox has been added in the Deform dialogue window.

The image below shows the difference for the bending:
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(1) Part; (2) Sketch; (3) Bending, local; (4) Bending, global

Furthermore, HiCAD will now check whether your inputs result in unwanted self-intersections before carrying out
the deformation. If this is the case, the following message will be displayed:

Edge functions - 'Insert polyline' function with Feature log entry

The "2 points" function at 3-D Standard > Tools > Edge > New, Insert... has been renamed to Insert
polyline. Also, the created polyline will receive a Feature log entry called Isolated edges.
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Views

Display of old sectional/detail views and cut-outs

Before HiCAD 2017 SP2, sectional views, detail views and cut-outs that are not up to data were only indicated in
the ICN by strikethrough view names. From SP2 onwards, such views are also indicated by a red cross in the draw-
ing.

If you do not want the crossed-out representation in the drawing, you can change this in the Configuration Editor at
System settings > Visualisation > Views, where you can deactivate the Cross out old cut outs, sectional views and
detail views in graphic checkbox.

Sketch lines and axes

No sketch elements and axes in (main) assemblies

Assemblies are normally used for creating a logical part structure. Apart from assembly points you will rarely be
provided with any geometries as auxiliary parts for the CAD structure. Therefore, the creation of sketch lines while
the assembly is active will no longer be possible (as with 3-D surfaces and edges) from HiCAD 2017 SP2 onwards.
In this way an accidental placing of sketch lines in assemblies will be automatically prevented. An insertion of
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assembly points and isolated points, however, is possible. Of course, you can still create a new sketch with the func-

tions Sketch and 3-D Sketch while the assembly is active. Please note however that the sketch will
then become the active part to which the subsequently line elements will be assigned.

Axes created with 3-D Standard > Tools > Crossh cannot be inserted if the active part is an assembly or main
assembly. In such cases the following message will be displayed:

Simulation

New options for video creation

Additional options are now available for video creation.
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n At the start and at the end of the simulation a still image can be shown before (Pre-video time) and after (Post
video time) the video. Specify the duration of the still image.

n Also new is the option to repeat simulations in a video. To do this, activate the Repeat checkbox. You can then
specify how many times the simulation is to be repeated in the video. The following directions are possible:
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forward
Each repetition begins with the start of the selected time interval.

backward
Each repetition begins with the end of the selected time interval.

forward/backward
Each repetition consists of one simulation in forward, and one in
backward direction. The repetition begins with the start of the selec-
ted time interval.

backward/forward
Each repetition consists of one simulation in backward, and one in
forward direction. The repetition begins with the end of the selected
time interval.

For the directions forward / backward and backward / forward you have the option to add an additional pass
of the simulation after the last repetition by activating the corresponding checkbox.
Additional still images can be inserted between the .individual repetitions.
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3-D Dimensioning + Text

Annotations by part type

The automatic annotations by part type have beenmodified in the Itemise part function.

If this option is active it will be proceeded as follows: a template will be automatically selected for the respective
part type. The following templates are assigned to the part types:

n Steel Engineering plates: PosNummerStb_Blech.fdt

n Steel Engineering beams: PosNummerStb_Profil.fdt

n Sheet Metal: PosNummer_Kantblech.fdt

n General parts: PosNummer_Allg_Bauteil.fdt

For all other parts the PositionsNummer.fdt template will be used.

Sketches

Create spirals
If you select a planar cylinder barrel surface or a coordinate system axis to determine the spiral axis, no reasonable
axis length can be assigned. Therefore, the Axis length checkbox will be greyed out in such cases as of SP1.
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Processing and reuse of spirals

Spirals are automatically parameterised upon their creation, i.e. a corresponding HCMmodel will be generated. Via
this HCM model spirals can be changed subsequently. If the spiral is saved as a 3-D part (KRA), it will be saved
together with the HCM model. This means that once created, spirals can be reused and individually adjusted in any
model drawings.

In the ICN the 3-D sketch will be marked with the symbol.

The associated HCM model will be displayed in the HCM window.

To modify a spiral subsequently you use the Change parameters function of the HCM context menu. To open the
menu, right-click on the HCM entry Spiral.
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Move points

When selecting single lines or lines in a rectangle, neighbouring points will be automatically selected with the Move

points function . If an already selected line is selected again, only the single line will be selected. In order to
deselect neighbouring points you have to click on them again. Full circles and full ellipsis do not have any visible
seam point.

An example:

If the line (1) is selected in the image, the neighbouring points will be selected, too, i.e. 3 elements are selected (2).
If the line is selected again (3), the line will disappear from the selection; however, the neighbouring points remain
selected (4).
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Process/model parts

Change assembly type

Use this function to change the assembly type of individual or multiple assemblies.

To do this, activate the desired assembly or, via multiple selection (CTRL + left-click), several assemblies. Right-

click the selected assembly or assemblies and choose Properties > Assembly type .

HiCAD will then display the Convert assembly dialogue window.

There you can choose the new assembly type from a listbox.

Click OK to close the window and apply the new assembly type.

Please note that the assembly type cannot be changed for main assemblies and locked assemblies.

Simplify

Delete structure parts

The "Delete superordinate parts" function has been revised and renamed to Delete structure parts .

When executing the function, please note the following:

1. The function will always be applied to the complete model drawing.

2. The subsequently listed parts will always be deleted, irrespective of whether they are superordinate or sub-
ordinate parts:

l Assemblies andmain assemblies - even if they contain, e.g. assembly points,

l Dummy parts,

l Point parts (parts with isolated points) and

l Plant Engineering parts without geometry, i.e. empty Plant Engineering parts containing only points.

3. All parts not mentioned in Point 2. will be preserved. Besides classic solids, the following parts will remain, i.e.
they are treated like solids:

l Edge parts (parts with free edges / 3-D sketches),

l Surface parts (parts with free surfaces),

l Sheet Metal main parts,
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l Superordinate parts of multi-part beams and profiles (e.g. series beams/profiles), and

l Bolting groups.

4. The parts to be deleted will not only be deleted as superordinate parts, but even if they are subordinated to parts
that are not to be deleted (see 2.) - for example, if a dummy part is subordinated to a solid or to a Sheet Metal
main part.

5. If parts that are not to be deleted are located beneath solids, they will be moved to the uppermost level of the
part structure.

l For example, if a solid is located directly beneath a dummy part, and beneath the dummy part there is
another solid, the dummy part will be deleted and the solid beneath it will be moved to the uppermost level.

l This rule also applies to solids which are located directly beneath other solids.

l Excluded from this rule are solids beneath Sheet Metal parts, multi-part beams/profiles, and bolting groups
(see 3.) The solids contained therein, e.g. flanges and bend zones beneath Sheet Metal parts, will be pre-
served.

Points 4. and 5. also concern parts beneath referenced parts. After calling the function you can specify in the dia-
logue window shown below how to proceed here:

Leave referenced parts unchanged
This is the ISD default setting.

Break up referencing if required
If parts beneath referenced parts are deleted or moved to the uppermost level, the referencing and the link to
HELiOS (if any) will be removed.

Example - Left: before; Right: After execution of function
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If parts to be deleted are located beneath non-referenced parts that are only locked via HELiOS, and the
Break up referencing if required option has been selected, the links to HELiOS will be removed. This will also hap-
pen if in the Configuration Editor at System settings > Referencing the Lock parts against processing if HELiOS
article master is locked checkbox is active.

Views

Panorama default settings

The default setting in the Panorama tab of the Visual effects docking window has been changed. The ISD default
panorama is set to DREIZINNEN.

Hide/Show processing planes

To hide and show processing planes in active views, open the context menu for views by right-clicking the pink
dashed view frame. Open the Others sub-menu beneath Hide/Show parts and choose one of the following func-
tions:

Processing planes - Hide

Processing planes - Show
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Views

Hide/show edges: Assembly points and weld seam edges

The Show/hide edges in view function now also allows a hiding and showing of assembly points and symbolic
weld seam edges in the active view. The dialogue window has been expanded accordingly for this purpose.

The default settings for this dialogue window can be changed in the Configuration Editor , at Drawing >
Views > Hiding and overlapping of edges.
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Sketches

Revised "Spirals" function

The Spirals function has been revised and features a redesigned dialogue window:
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Besides greater user-friendliness, the new dialogue offers the following advantages:

n The spiral will be immediately visualized dynamically.

n More accurate curves are created.

n Besides cylindrical spirals, conical spirals can be created.

n Start and end of the spiral can be modified.

The creation of spiral-shaped curves as polygon lines or compound curves can be achieved by a subsequent
applying of the Replace line function

Point options during drawing of sketches

If the sketching tool is active during drawing of sketches, and you press one of the keys for calling of a numerical
point option (A, D, K, N, P, R, W), the corresponding point options menu for value input will now be opened. The
Distance menu will now only be displayed when pressing the space bar.
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Dimensioning

Variable dimensions

The new Variable dimensions function is a smart, variable dimensioning function that combines a multitude
of individual dimensioning functions.

It is thus possible to quickly create

n axially parallel or free linear dimensions,

n angular dimensions between two edges,

n arc dimensions as well as

n circle, radius and diameter dimensions

with only one function. Depending on the selected element, e.g. edge, full circle or point, it directly creates the "cor-
rect" dimension or, if several dimensions are possible, allows you to choose the desired dimension.

Example: Full circle

Here, one of the bores (1) has been selected. In this case, the function will suggest the dimensioning types dia-
meter dimension (2), radius dimension and angular dimension.
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The following table provides an overview over the possible dimensions for the different base points.

Base point Dimension Selection

2 points Linear
dimension

n Linear dimension, axially parallel

n Linear dimension, free

Edge Linear
dimension

n Linear dimension, axially parallel

n Linear dimension, free

Edge + point Distance
between
edge and
point

n Linear dimension, axially parallel

n Linear dimension, free

2 parallel edges Distance
between
edges

n Linear dimension, axially parallel

n Linear dimension, free

2 intersecting
edges

Angle
between
edges

n Angular dimension

3 points Angular
dimension

n Angular dimension

Full circle Diameter
dimension,
axially par-
allel

n Diameter dimension, axially parallel

n Diameter dimension

n Radius dimension, axially parallel

n Radius dimension

n Angular dimension

Full circle + edge Distance
between
circle and
edge

n Linear dimension, axially parallel

n Linear dimension, free

Circular arc Radius
dimension,
axially par-
allel

n Radius dimension, axially parallel

n Radius dimension

n Diameter dimension, axially parallel

n Diameter dimension

n Arc dimension

n Angular dimension

A surface of a
sphere, a cylinder,
a cone or a torus

Diameter
dimension,
axially par-
allel

n Diameter dimension, axially parallel

n Diameter dimension

n Radius dimension, axially parallel

n Radius dimension
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Changed 3-D Dimensioning + Text tab

Individual dimensions

As the new variable dimensioning combines many of the previous individual dimensions the respective functions
have been removed from the tab. These are the following functions (incl. subfunctions):

n Circle, radius dimension

n Diameter dimension

n Radius dimension

n Arc dimension

n Linear dimension, axially parallel

n Linear dimension, free

All individual dimension functions that are not covered by Variable dimensioning can be found under Individual
dimensions.

The Individual dimensions menu
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Surface/Tolerances

The Surface/Tolerances function group has been renamed to Surface/Edge.

The Surface characters function has been renamed to Surface finish.

The functions for Symbols can now be found in the Surface characters menu (at 3-D Dimensioning + Text > Sur-
face/Edge > Surf... > ... ).

The Edge state function is a new function.

Designate edge state

Workpieces are not infrequently produced with unwanted burrs or undercuts (missing material). You can use the

Edge state function to describe the condition the inner and outer edges of a workpiece according to ISO
13715.
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(1) Inner edge - Transition (from 0,3 to 0,5)
(2) Outer edge, no burrs (from 0 to 0,3)
(3) Outer edge, sharp (with or without burrs, from 0 to 0,3)

The pre-settings for the designation of edge states can be specified in the Configuration Editor at Drawing > Annota-
tions > Edge state.

Model/Process parts

Envelope part

When you select the Envelope parts function, a progress bar will now be displayed both for Preview and
Apply. Furthermore, the message Unknown problem has been replaced with the more precise message Part could
not be generated.

Standard Parts / Standard Processings

Purchased parts / Factory standard parts

At 3-D Standard > Standard Parts > BoltScrew > Others >... you will find the new

Purchased / Factory standard parts

function.

Use this function to insert parts from the catalogue Factory standards > Purchased/Factory standard parts into
your drawing, e.g. end caps or glass holders. When you are working with HELiOS, these parts will always preserve
their article master, irrespective of the project to which they belong, i.e. these parts will behave like standard parts.

These parts are of particular significance when working with the Management + BIM module, as it must be
ensured here that the parts/assemblies with the manually created/assigned article masters will preserve their article
masters when being inserted in an existing project. Furthermore, sub-parts in assemblies must not be BOM-relevant
here.
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Catalogue Editor

Service Pack 2 2017 (V 2202)

New Titgemeyer parts standard parts
New Titgemeyer standard parts can be found in the catalogue Factory standards > User-defined nuts > Tit-
gemeyer:

n Flat head blind rivet nut RIV TI, open

n Flat head blind rivet nut RIV TI
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New FISCHER standard parts
New FISCHER standard parts can be found in the catalogue Factory standards > User-defined fasteners:

n User-defined anchors > Fischer >Anchor rod RG M and

n User-defined dowels > Fischer > Universal dowel UX.

Retaining rings acc. to DIN 9925 and 9926
The catalogue Fasteners > Retaining rings contains new retaining rings according to DIN 9925 and DIN 9926.

The matching grooves can be found in the catalogue Processings, general > Shaft processing > Grooves for
retaining rings.

New ALUCOBOND® semi-finished products
In the Factory standards catalogue, further tables for ALUCOBOND® semi-finished products and coatings are
available:

n Semi-finished products at Factory standards > Sheets > Alucobond

l ALUCOBOND Anodized Look

l ALUCOBOND Ligno

l ALUCOBOND naturAL

l ALUCOBOND Spectra & Sparkling Colours

l ALUCOBOND Terra

l ALUCOBOND Urban

n Coatings at Factory standards > Surface treatment > Alucobond

l Coating ALUCOBOND Anodized Look

l Coating ALUCOBOND Ligno

l Coating ALUCOBOND naturAL

l Coating ALUCOBOND Spectra & Sparkling Colours

l Coating ALUCOBOND Terra

l Coating ALUCOBOND Urban
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ZETA profiles
At Factory standards > Series > Profile installation > SBE you will now also find ZETA profiles which are frequently
used as roof transoms for steel halls.

New Usage
In the catalogue Factory standards > Usage > Civil Engineering > Steel Engineering you can find a new usage in
the Railing table:

Designation: GLASS

CONFIGKEY: GLASSPANE

This usage will now be automatically assigned to glass elements created with the Railing Configurator.

58 / 294 What's new?

Catalogue Editor



Major Release 2017 (V 2200)

Transfer standard parts to HELiOS
The transfer of standard parts to HELiOS now takes place must faster.

Purchased parts / Factory standard parts
A new catalogue is available at Factory standards > Purchased/Factory standard parts. When you are working
with HELiOS, these parts will always preserve their article master, irrespective of the project to which they belong,
i.e. these parts will behave like standard parts.

These parts are of particular significance when working with the Management + BIM module, as it must be
ensured here that the parts/assemblies with the manually created/assigned article masters will preserve their article
masters when being inserted in an existing project. Furthermore, sub-parts in assemblies must not be BOM-relevant
here.

Use the new Purchased/Factory standard parts function in HiCAD to insert the parts into your drawing.

New factory standard parts and tables
Numerous new standard parts - especially for roof, wall and facade elements - have been added to the Factory
standards catalogue:

User-defined bolts + screws

n ALOCUBOND

n Ejot

n Hilti

n SFS

Sheets > ALUCOBOND

n Composite panel*

* with assigned colours

User-defined materials

n Compoundmaterial ALUCOBOND

Surface treatment > Profile installation >
ALUCOBOND

n Metallic colours

n Solid colours

Factory beams > ALUCOBOND

n End profiles

n Cover profiles

n Corner connector profiles

n Profile edgings

n Window connection profiles
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n Hat profiles

n Transversal connection profiles

n Joint profiles

n Mounting profiles

n Support profiles

n Reinforcement profiles

Factory beams > Schrag profiles

n C-profile

n CL-profile

n T-profile

n Z-profile

User-defined nuts

n Folko

n Titgemayer

User-defined countersinks for rivets

n Titgemeyer

User-defined countersinks for blind rivet nuts

n Folko

User-defined bores for blind rivet nuts

n Folko

n Titgemeyer

User-defined anchors

n FISCHER Bolt anchor FBN II

Purchased / Factory standard parts

n End caps

n Corner glass holder

n Glass holder

n ALUCOBOND Spring clip

Usage > Profile Installation > ALUCOBOND

n ALUCOBOND Tray panels

n ALUCOBOND composite panel

Semi-finished products-dependent part colour
The catalogues at Factory standards > Sheets contain columns that allow the assigning of a special part colour to
semi-finished products, e.g. for coated sheets. Furthermore, you can assign a manufacturer-specific code, e.g. an
internal colour code for ALUCOBOND sheets, which will also be considered in BOMs.
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Feature Technology

Service Pack 2 2017 (V 2202)

Feature for edge functions - Insert polyline

The Insert polyline function at 3-D Standard > Tools > Edge > Insert > ... now also generates entries in the
Feature log. The creation of polylines will obtain a Feature log entry called Isolated edges.

Clone processings - Mirror transformation

The Clone processing function now offers a new cloning pattern, namely, the Mirror transformation. This
allows you to mirror clonings on a defined plane.
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Feature recalculation for identical parts
Identical parts will now only be calculated once in Feature recalculations, which reduces the calculation time for
variants significantly.
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Clone processings: Identifying rotation axes of cylinder and torus surfaces

The Clone processings function now allows a direct identifying of rotation axes of cylinder and torus sur-
faces. To do this, simply identify the surface of the element the rotation axis of which you wish to use.

Clone processings: Attach flange
The list of processings that can be copied with the Clone processings function now also includes the Sheet Metal
function Attach flange.
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Service Pack 2 2017 (V 2202)

KNTPAR.DAT settings moved to Configuration Editor
The settings from the KNTPAR.DAT file have been moved to the Configuration Editor. You can now find the settings
at System settings > Visualisation > 3-D.

Mounting drawings - Rearrangement of views upon update
As with production drawings, you can now also switch off the automatic rearranging of views upon update in mount-
ing drawings created with the Management + BIM module. makes sense if, for instance, you have deliberately
moved some views and want to keep their new position.

This setting can be specified in the Configuration Editor at PDM > Management+BIM > Production drawings >
Rearrange views when updating mounting drawings.
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GRAPAR.DAT settings moved to Configuration Editor
The settings from the GRAPAR.DAT file have beenmoved to the Configuration Editor. You can now find the settings
at System settings > Visualisation.

Production drawings

Placing of annotations

Annotations of beams and plates in production drawings can take place with or without leader lines. This behaviour
can be specified at Automatic drawing derivation > Production drawing > Annotation > Placing of annotation.

Default configuration for assemblies without usage

You can now also define default configurations (usage-dependent settings) for detail drawing (production drawing
for one view group) creation for assemblies to which no usage has been assigned. The selection of part types at
Automatic drawing derivation > Production drawing > Usage assignment has been expanded accordingly for this
purpose.

Avoiding of duplicate sectional views

You can now specify at Automatic drawing derivation > Production drawing that sectional views with identical
contents are to be created only once in the workshop drawing. To do this, activate the Avoid multiple sectional
views checkbox.

Behaviour of deleted dimensions when updating drawings

If you delete an automatically generated dimension (e.g. one that is based on a dimensioning rule) in a view of a
workshop drawing, this dimension will not be restored when you update the workshop drawing!

If you do not want this behaviour, you can switch it off: Go to System settings > Annotations > Dimensioning, 3-D
and deactivate the Correction when deleting workshop drawing dimensions checkbox.

Please note:

The new behaviour works only in new workshop drawings created with HiCAD 2017 SP1 or with updated workshop
drawings!
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Unprocessed and processed sheets
One distinguishes between sheets with identical cross-sections (unprocessed sheets) and processed sheets.

n As "cross-sectionally identical" (unprocessed) are considered all sheets with at least one bend zone, parallel
front edges of the flanges (width of flange) and without any further processings such as bores, subtractions etc.
For these sheets, no drawing is normally required, but only a BOM.

n All other sheets are considered non-identical and processed. For these sheets a drawing is required.

Production drawings for sheets with identical cross-sections

The output of cross-sectionally identical sheets can now be suppressed in the workshop drawing. To do this, open
the Configuration Editor, go to Sheet Metal and activate the checkbox for the parameter Suppress production
drawings for sheets with identical cross-sections.... The checkbox is deactivated by default.

Steel Engineering BOM (Excel) - Distinguishing unprocessed and processed

To be able to distinguish between unprocessed and processed sheets in the BOM, the following settings are
required:

1. In the Configuration Editor at Sheet Metal, the Special treatment for sheets with identical cross-section
checkbox must be active (default).

2. The new template HiCAD_Stahlbau.2201.0must have been selected for BOM creation.

An additional Excel sheet will then be created for unprocessed sheets.

CAM data for unprocessed sheets

In the Configuration Editor at PDM > Management + BIM > External production drawings > CAM data for unpro-
cessed sheets you can specify whether the "unprocessed" sheets are to be considered for the creation of the CAM
data or not.

Placing of annotations in mounting drawings
Annotations of beams and plates in mounting drawings can take place with or without leader lines. This behaviour
can be specified at Automatic drawing derivation > Mounting drawing > Annotation > Placing of annotation. The
checkboxes is activated by default, i.e. the annotations will be placed directly onto the plates or next to the beams,
respectively. If there is not enough space, the annotation will be placed with a leader line.

If the checkboxes are deactivated, the annotation will always be applied with leader lines.

Import texts from 3-D DXF
When importing 3-D files from AutoCAD (DXF, DWG) you have the option to transfer the annotations of the AutoCAD
model to HiCAD by activating the Take texts from model option. In the Configuration Editor you can change the
pre-setting for the parameter at Interfaces > General 3-D interfaces > Take texts frommodel.

New parameter "Plan types"
The new parameter "Plant type" (at PDM > Management + BIM) determines which customer drawing creation
options are to be offered when choosing the new BIM function "Customer drawing".
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Workflow status in ICN
Parts from released drawings and parts from drawings in "Checkup" status are marked accordingly in the ICN.
These indicators of the Workflow status were automatically updated in previous versions.

In order to speed up the build-up of the ICN structure of very large model drawings or in case of very slow con-
nections to HELiOS, you have now the option to specify the frequency of this automatic updating at PDM > Man-
agement + BIM > Workflow status in ICN.

Generation of STEP files separately for beams, plates etc.
The generation of part data in STEP format can now also take place separately for beams, profiles, plates, sheets
glass panes and gratings. This separation was previously only possible for assemblies.

For this purpose the settings at PDM > Management + BIM > External production drawings > Collect part types
for STEP export have been expanded accordingly.
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Major Release 2017 (V 2200)

View mode
The View mode enables the precise displaying of changed settings in the Configuration Editor.

Normal All settings will be displayed in the Configuration Editor.

Only
changed
values

Only changed values of the current user profile, which are marked with the pencil icon , will be
displayed.

Only
changed
default
settings

This view mode is only activated if settings in the ISD profile were changed in an update and differ
from the company-specific default settings in the Administrator profile.

If you load the company-specific Administrator profile after the update and select the Only
changed default settings function only the changed settings will be displayed. The values of the
changed settings stem from the company-specific Administrator profile.

Sheet developments
The settings in the Create sheet development dialogue window can now be saved as Favourites and re-used at any
time.

You can load the Favourites in the Configuration Editor at Sheet Metal > Sheet development > Default settings as
pre-settings for new drawings.

Changed settings for Management+BIM

If you have activated theManagement + BIM  checkbox in the HiCAD Parameter configuration dia-
logue window, the Lock parts for other users via HELiOS article master checkbox will be deactivated
in the Configuration Editor at System settings > Referencing.

Configuration of the assembly article number
For creating new assemblies, creating assemblies from already existing parts and the automated creation of assem-
blies - e.g. in Steel Engineering - the ISD default value suggestion is Assembly. This setting can now be changed in
the Configuration Editor via Steel Engineering > Assembly.

The ISD default setting is the highlighted text in the HiCAD text key, TEXTE_STB325.

If you want to use a customized Text you can simply enter it into the field. However, the Text key checkbox has to
be deactivated.
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Hide/Show edges
Via the Hide/Show edges function it is also possible to hide or display assembly points as well as symbolic weld
seam edges.

The default settings for this dialogue window can be changed in the Configuration Editor via Drawing > Views > Hid-
ing and overlapping of edges.

Designate edge state
The pre-settings for the designation of edge states can be specified at Drawing > Annotations > Edge state.

Itemisation
In HiCAD 2017 you can change the Itemisationmode via the Configuration Editor. One distinguishes between

•Itemisation up to HiCAD 2017 (current itemisation) and

• Standard (will replace this itemisation with the release of HiCAD 2017 SP 1).

Important:

Please note that the itemisation mode Standardhas not been officially released yet and will only be made available
for test purposes and in agreement with staff members of the ISD! Therefore, the current default itemisation mode
is the Itemisation up to HiCAD 2017 mode.

Changed presetting for visualisation
When you open the Computer Parameter Configurator (HiCAD\exe\ParKonfigComp.exe)tool and choose the
default template Steel/Metal Engineering there, the parameter Vertical axis during dynamic rotation about 3-D
point in the Configuration Editor at System settings > Visualisation will be set to Greatest rise, spatial. This setting
will affect the vertical rotation axis when performing multiple rotations with the Rotate view dynamically about 3-D

point function.

Production drawings

Changed default settings in Configuration Editor

The default settings at Automatic drawing derivation > Production drawing have changed (depending from the
current parameter configuration).

Path Parameter old new *1 new *2

Production drawing Leave external draw-
ing open

Close
drawing

Close
drawing

Leave drawing
open, switch to ori-
ginal drawing

Production drawing > Drawing Centre individual
view group

Production drawing > Drawing >
Drawing frames

Height / Width 0 / 0 410 /
584

410 / 584

Production drawing > Annotations
> Grid annotation

Grid annotation:
Line type of axis

1 5 5
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Path Parameter old new *1 new *2

Grid sub-system
annotation: Line
type of axis

1 5 5

Production drawing > Annotations
> Grid annotation > Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Annotations
> Grid annotation > Sub-system,
Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Devel-
opment

Dimension bend
lines

1* Default template: Steel/Metal Engineering / Management+BIM

2* Default template: Mechanical Engineering / Plant Engineering and User-defined template: ISD Default

Development of Sheet Metal parts

In the Views for sheets dialogue window you can now specify the position of the development in the view group.
The development can be arranged at the top, the bottom, on the right or left in the view group.

When working with usage-dependent configuration templates, the arrangement chosen in the corresponding tem-
plate will be preset. This presetting can be changed in the Configuration Editor at Automatic drawing derivation >
Production drawing > Usage-dependent > name > View group, with name being the name of the relevant tem-
plate. There you can choose the desired arrangement via the parameter Sheet development: Position in view
group.

Hide boltings

The visibility of boltings can now be separately set for each usage in the Configuration Editor, namely, at Automatic
drawing derivation > Production drawing > Usage-dependent > .... > Views .

Specify position of BOM

Position and layout of the BOMs can be specified separately for each usage at Automatic drawing derivation > Pro-
duction drawing > Usage-dependent > ... > View group . If the drawing parameters are loaded from a con-
figuration that has been saved to the Configuration Editor, the corresponding settings from the Configuration Editor
will be pre-set in the dialogue window.
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Automatic sectional view creation for attached parts

According to the ISD default setting, sectional views are automatically created for Steel Engineering plates running
transversely or diagonally to the main part axis. When working with configuration templates, you can specify for
each usage which sectional views are to be created for attached parts. The setting can be defined in the Con-
figuration Editor at Automatic drawing derivation > Production drawing > Usage-dependent > name > View
group, with name being the name of the relevant template.

HiCAD drawing frames in P+ID
In the Configuration Editor at Plant Engineering > P+ID > DIN frame in P+ID you can specify which HiCAD frames
should be used instead of the P+ID frames. In particular, you can specify the text entries for HiCAD frames here.
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Parametrics (HCM)

Service Pack 2 2017 (V. 2202)

New symbols for positional HCM constraints
The symbols for positional HCM constraints have been revised. They now look as follows:

Tangential Coincident

Perpendicular Parallel

Concentric Mid-point

Symmetric Equal distance

Equal parameter Equal direction

Equal 1st derivation Equal 2nd derivation

Equal bend

In the Configuration Editor at System settings > Annotations > HCM_Symbol you can influence the display of
these symbols: Besides symbol and background colours you can also specify the size of the symbols here.

The previously available setting options at System settings > Annotations > Dimensioning, 3-D > HCM dimen-
sions > HCM symbols have been removed.
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Major Release 2017 (V 2200)

Taking into account of switched off external references in the Sketch HCM
For instance, if a part has been created as an extruded part from a sketch that contains external references (e.g.
distance constraints to a different part), these used to be considered in older versions - even if the taking into
account of such external references was explicitly switched off for the extruded part.

This behaviour has been corrected in Version 2200; in such cases the external references will be ignored as reques-
ted.
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Bill of Materials / Report Manager

Service Pack 2 2017 (V 2202)

Configuration of attribute transfer for BOMs from product structures
When generating a BOM from a product structure you have now the option to determine which attributes are to be
transferred to the Report Manager in the process. In previous versions, a change in the
2D3DREPORTMANAGER.MAC file was required for this.

From SP2 onwards, this setting can be specified in the Configuration Editor at System settings > HELiOS, where
you will find the parameter Attributes for BOM via product structure.

If you have chosen the Only selected attributes setting here, only those attributes will be transferred that are spe-
cified in the PV_KONFIG.DAT file.

For new installations this parameter is set to Only selected attributes by default; for update installations it is set to
All attributes. The previous setting from 2D3DREPORTMANAGER.MAC will not be applied.
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Service Pack 1 2017 (V 2201)

Parameter configuration / Steel Engineering BOMs
If the Steel / Metal Engineering option has been set in the HiCAD Parameter configuration dialogue window, the
Steel Engineering-specific BOM configuration HiCAD_Stahlbau.rms will be used as default configuration.

Steel Engineering BOM (Excel) - Differentiating between unprocessed and processed sheet metal
For Sheet Metal parts you now distinguish between sheets with identical cross-sections (unprocessed) and pro-
cessed sheets. Unprocessed sheets with identical cross-sections are characterised by at least one bend zone, par-
allel front edges of the flanges (width of flange) and no further processing, e.g. subtractions, bores etc. For these
sheets a drawing is not necessary, only a BOM. All other sheets count as unalike and processed.

In order to differentiate between unprocessed and processed sheets in the BOM

1. the Special treatment for sheets with identical cross-sections checkbox has to be activated in the Con-
figuration Editor under Sheet Metal (by default deactivated).

2. the new template HiCAD_Stahlbau.2201.0 has to be used when creating a BOM.

In this case an additional spreadsheets for unprocessed sheets will be added in the Excel BOM.

Moreover, for sheet metal and unprocessed sheets you can optionally view images of the sectional view (with
dimensions) in the BOM. To do so, go to the spreadsheet Settings in the HiCAD_Stahlbau.2201.0.xslx template,
then to the Create column and change the value for Sheet Metal parts with image to true . The ISD default setting
is false.

For unprocessed sheets with identical cross-sections only one image will be created.

The depiction with images can be found in the spreadsheets:

n Unprocessed sheets

n Unprocessed sheets with image
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Example:

The displayed drawing contains 5 aluminium sheets. Sheet 5001 and 5002 have different sheet depths, but they
have identical cross-sections and are unprocessed. This does not apply to sheet 5000 as it has a subtraction, thus it
is processed. Analogous to that, sheet 5003 is unprocessed and sheet 5004 is processed due to the subtraction.

If the Special treatment for sheets with identical cross-sections checkbox is active, sheet 5001, sheet 5002 and
sheet 5003 will receive special treatment in the BOM and two spreadsheets will be added.
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Example - Spreadsheet Sheet Metal parts with image
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Example - Spreadsheet Unprocessed Sheet Metal parts with image
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Expanded short shipping list
For bigger drawings you oftentimes need more than the first level of the part structure in the short shipping list. This
can now be modified by using the filter attribute %Stufe in the setting file for Excel BOMs (e.g. HiCAD_Stahl-
bau.2201.0.xlsx). You can for example set the filter criteria to 1,2 and set the exclusion filter to false, which means
that the shipping list contains level 1 and 2 of the part structure.
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Major Release 2017 (V 2200)

Cut symbols in Excel BOMs via product structure
Cut symbols are now available in Excel BOMs created via product structures: In your template, use the variables
!table!Bauteil.COMPONENT_CUTTYPE_WEB! or !table!Bauteil.COMPONENT_CUTTYPE_FLANGE!,
respectively (instead of !table!H_$09! and !table!H_$10!).

Click here for further information on special attributes for Excel BOMs created from product structures.

Expanded BOM template for Steel Engineering
The supplied Excel template for Steel Engineering Bills of Materials has been slightly modified. On the Shipping list
sheet, the Qty./Assy. column that indicates the number of parts per assembly has been added to the right of the
Total qty. column that indicates the total number of parts.

Faster BOM creation
Data transfer to the Report Manager has been speeded up significantly. The increased speed becomes particularly
apparent when working with large model drawings consisting of very man parts.
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Automatic creation of images of Sheet Metal parts
When generating Excel BOMs you have now the option to create images Sheet Metal parts and insert them into the
BOM automatically. This function is by default only contained in the template HiCAD_Stahlbau.2200.0.xlsx and is
deactivated there. To activate it, open the file SYS\HICAD_STAHLBAU.EN.2200.0.XLSX. Open the Settings sheet
and, in the Bills of Materials table, switch the Create value for the Sheet Metal parts with image row from von
false to true:
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Viewer

Major Release 2017 (V 2200)

Viewing of 2-D files
Similar to the .KRA files in 3-D, there are now also figure archives in 2-D with the file extension .FGA. These contain
the previous 2-D data (.FIG), the database attributes (.FIG.DBA2) and the attribute container data (.FIG.ATC) and
replace the previous 2-D files.

The new .FGA format now also allows the displaying of the 2-D figures in the HiCAD Viewer.
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Sheet Metal

Service Pack 2 2017 (V 2202)

Enhanced 3-D development

Simplify

Use the new Simplify function to show corners and relief grooves in the 3-D development within the circle of the
specified snap radius in simplified representation.

Right-click on the 3-D development, choose Process development > Simplify. Enter the radius for the snap circle.
Via the Feature log you can change the radius, deactivate or delete the feature.

(1) Relief groove

(2) Simplified representation
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Representation in developments

The representation of bore patterns, punches and mouldings in the 3-D development can be specified in the Sheet
development default settings dialogue (Extended settings > Extended representation) during creation or modi-
fication of the 3-D development.

Use the Planar representation for mouldings to show bore patterns, punches andmouldings in 2-D.

Tool number

You can now output a tool number (WZNR column) from the Catalogue Editor for punching, moulding and emboss-
ing tools in the 3-D development.

When you create or change a development, activate the Punching, moulding and embossing tools checkbox.

The tool number will then (depending on the chosen position in the Text Editor) at the respective processing of the
sheet.

Manual moving of auxiliary texts

If you move the cursor over a text in the 3-D development, the text will be highlighted in magenta. If you now press
and hold down the left mouse button you can move the text. When you update the development the text will be
moved back to its original position.

Favourites for developments

The settings of the Sheet development dialogue window can be saved as Favourites and be reused at any time. To

do this, right-click on the symbol .

The default setting for COBUSNCAD has now been predefined and saved as Favourite.
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COBUS NCAD reduces the startup costs for new CNC machines due to the possibility to pass the CNC master data
to the machines.

Error message for incorrect bending simulations and sheet developments
If a bending simulation or a sheet development cannot be correctly calculated, an appropriate error message will
be issued. A disrupted calculation can, for instance, be caused by non-tangential transitions or edges between
flange and bend zone.

The error message appears next to the OK button.

While sheet developments will be cancelled, bending simulations will still be performed as far as possible.

The blue edges are tangential edges(green (convex) and red (concave) edges are non-tangential edges).

Sheet from sketch
The Sheet from sketch function has been enhanced and now offers the following advantages:

n a preview is displayed

n the sketch can be modified during the creation process

n you can double-click the Feature and change input data in the dialogue window.

As before, you can find the New sheet from sketch functions for main parts and sub-parts in the New function
group of the Sheet Metal tab. Select the New sheet from sketch function.

The Sheet from sketch dialogue window will be displayed:
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1. Sketch

2. Sheet parameters

3. General

4. Apply/discard changes

If your drawing contains only one sketch, this sketch will be automatically chosen for the creation of the new sheet.
If there are several sketches, you need to select the sketch from which you wish to create the sheet. You can also

call click the symbol and choose the New sketch in plane function, and ten draw a new closed polyline
with the Draw functions on the Sketch tab.

As soon as you have identified the sketch, a preview of the new sheet will be shown. If you prefer a different sketch

for sheet creation, click the icon beneath Sketch and identify a new sheet.

If the sketch contains several, closed polylines, a sheet with flange will created from them. If there are polylines
that are not closed, an error message will be displayed:
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To modify the sketch, click the symbol and choose Process sketch . You can then process the sketch using
the functions of the Sketch tab. You end sketch processing via the processing dialogue and will be redirected to the
Sheet from sketch dialogue window.

Even if you delete the sketch from the part structure, you have still the option to change the sketch via the feature
log.

The standard for semi-finished products can be taken from the HiCAD Catalogue Editor by clicking the icon.
The selection of a semi-finished product influences the sheet thickness, the material and the article number. If you
double-click the feature Sheet from sketch you have the option to activate or deactivate the semi-finished product
later.

By specifying the fitting direction you determine the direction for the applying of the sheet thickness (+ or – Z-axis).

Frequently used part are often saved as referenced parts. Such parts will then be additionally saved as individual
parts at the end of the function-related process, and will not be integrated as a "fixed" part into the drawing. If any
changes are then applied to this part, it can then be updated in the drawing.

To deactivate Feature logging during sheet creation, deactivate the Create feature checkbox. By default, this

checkbox is active .

The name of the sheet will be generated automatically. You can overwrite it in the Article No. text field if you have
not activated the Use semi-finished product checkbox.

Once you have entered all required data, you can create the new sheet. Click Apply to insert the sheet, while the
dialogue window remains open, allowing you to make further changes if desired. Click OK to insert the sheet and
close the dialogue window. Click Cancel to close the dialogue window and discard all inputs, without creating the
sheet.

Example:
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Welded corner
Use the revised Welded corner function to create a welded corner between two flanges of a Sheet Metal part. The
flanges can have different lengths and bend angles. For such cases you can choose between different types of
transitions.

When you activate the function the following dialogue window will be displayed:
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Proceed as follows:

1. Identify the two sheets, each at one of the two longitudinal edges of the front side.

If you want to identify a different front side, click the icon in the Edge area of the dialogue for identification.

2. Enter the angle for the welded corner.
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(1) 60° angle of welded corner

(2) 45° angle of welded corner

3. Specify the Clearance for the weldmaterial.

4. Enter a Bend radius for the bend zone.

5. If the flanges have different lengths, specify the handling of the bend zones in the in the Adjust bend zones
field.

The following options are available for a processing of flanges with different lengths or angles:

No adjust-
ment

The front surface remains unchanged.

Planar The front surface of the bend zone will be pulled back perpendicular to the
axis.

Linear The front surface of the bend zone connects both flanges. The result is a
planar front surface.

Bulgy
(inside)

The front surface of the bend zone connects both flanges. The result is a con-
cave front surface.

Hollow (out-
side)

The front surface of the bend zone connects both flanges. The result is a con-
vex front surface.

6. Enter the sheet thickness.

The standard for semi-finished products can be taken from the Catalogue Editor with a click on the icon. The
selection of the semi-finished product influences the sheet thickness, the material and the article number. With a
double-click on the Welded corner Feature you can later activate or deactivate the semi-finished product.

7. Choose and Allowance method.

To preserve the development of the welded corner, HiCAD offers you developments according to various cal-
culation methods - so called allowance methods - which take into account the material-dependent length changes
of the workpiece that occur during the bending process. You can choose between the most common, practice ori-
ented empirical allowance methods in HiCAD.

Each allowance method is represented by one particular system file, which have been appropriately prepared. In
practice, however, users will often want to create his/her own, user-defined methods. Before applying the welded
corner you can select a system file here.

8. Confirm your entries with OK.
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Once you have entered all required data, you can create the welded corner. Click Apply to insert the welded corner,
while the dialogue window remains open, allowing you to make further changes if desired. Click OK to insert the wel-
ded corner and close the dialogue window. Click Cancel to close the dialogue window and discard all inputs,
without creating the welded corner. Click Preview to update the welded corner after changes in the dialogue win-
dow.

Example:

(1) Welded corner

(2) Feature log

(3) Double-click the Welded corner Feature to open the dialogue window

Deleting flanges and bend zones
The Delete function cannot be applied to end zones or flanges in Sheet Metal parts with feature log.

If you activate a flange or bend zone and choose the Delete object function, the following message
appears:

Flanges and bend zones cannot be delet ed i f t he f ea t u r e l og is act i ve. The complet e Sheet Met a l pa r t wi l l
be delet ed .

Click OK to delete the complete sheet.

Click Cancel to end the function without deleting anything.

To avoid repeated display of the message, activate the Suppress message checkbox.
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If a Sheet Metal part has no feature log, the flange of bend zone will be deleted immediately, without any further
queries.

Transform / Clone flanges and bend zones

When an attempt is made to transform or move the bend zone of a sheet with features, the following message was
displayed in previous versions:

Funct i on not a l l owed f or sel ect ed par t / assembly. App l y f unct i on t o super or d ina t e pa r t / assembly?

This message will no longer be displayed. The function will now be applied directly to the Sheet Metal main part.

For Sheet Metal parts without features a moving of flanges and bend zones is allowed.

Settings for sectional views of sheets in production drawings
New in the Drawing derivation dialogue window is the Sectional views of sheets button. When you click this but-
ton, the following dialogue window will be displayed:

The following options are available:

n Scale of sectional views

n Angular dimensions in sections
Via this parameter you determine whether angular dimensions are to be created in sectional views or not.

n Offset go-side
For coated surfaces you can specify the distance for the go-side line.
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Service Pack 1 2017 (V 2201)

Create new base sheet
The Create base sheet function has been revised. You can now choose between the options Insertion via value and
Insertion via points. As soon as your value inputs are sufficient, a preview of the new sheet will be displayed.

A rectangular base sheet can be created as a main part or a sub-part. To create a sub-part, you first need to create
a main assembly with a subordinate assembly. If the assembly is then active, the base sheet is subordinated to the
assembly once you have selected the function.

Proceed as follows:

1. Choose the Base sheet, or Base sheet > Sub-part function, respectively.

This will open the Base sheet dialogue window.

1 Insertion via value

2 Insertion via points

3 Sheet parameters

4 General

5 Apply / discard inputs
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Insertion via value

2. Choose Insertion via value .

3. Enter the dimensions beneath Sheet parameters.

A preview of the new sheet will be displayed.

4. Identify an insertion point in your drawing.

If you want to change the insertion point, click the icon. Right-click and choose the Origin of the active coordin-
ate system as the fitting point, or change the fitting point on the base sheet.

If you choose the Select fitting point function, the base sheet will be shown as a glass model. Identify the new
point.

If the Apply immediately checkbox has been activated , the new sheet will be immediately inserted (provided
that the value inputs are correct), and can then be changed via the Feature log.

If the Close window after creation checkbox has been activated , the dialogue window will be closed after the
generation of the base sheet.

Insertion via points

When you choose the Insertion via points option you must first identify the insertion point of the base sheet
in your drawing. Then, you can define your base sheet dynamically by dragging. The second point can then be
freely selected in space and will be projected onto the base sheet.

The sheet parameters Width and Depth will be greyed out during dynamic dragging of the sheet. They will be cal-
culated from the model drawing and can later be changed via double-click on the feature.
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Sheet parameters

If you have created the base sheet with the Insertion via value option, you can modify all sheet parameters. If you
have chosen the Insertion via points, the Width and Depth fields will be greyed out. In this case you need to
modify the parameters via the Feature log.

If you use a semi-finished product from the Catalogue Editor, you will not be asked to specify the sheet thick-
ness. The Sheet thickness, the Material and the Article number for the base sheet will then be taken from the
Catalogue Editor.

Semi-finished products can also be activated/deactivated or changed subsequently. To do this, double-click the
Base sheet feature. The dialogue for base sheet creation will be opened. You can then activate or deactivate the

Use semi-finished product checkbox, or click the icon to choose a different semi-finished product. Click OK
to confirm your changes and apply the changes.

General

Frequently used parts should be saved as referenced parts. The part will then saved additionally as an individual
part at the end of the process and not incorporated as a "fixed" part in the drawing. If this individual part is modified,
you can then update the part in the drawing.

To deactivate the feature creation during the sheet creation, deactivate the Create feature checkbox . This

checkbox is activated by default .

The Article number of the sheet is automatically generated. You can overwrite it in the text field if you have deac-
tivated the Use semi-finished product checkbox.

Apply / discard inputs

After entering all required data you can create the new sheet. If you click Apply, the new sheet will be inserted, and
the dialogue window remains open. If you click OK, the new sheet will be inserted and the dialogue window will be
closed. If you click Cancel, your value inputs will be discarded and the dialogue window will be closed. If you have
activated the Apply immediately option, the data will be instantly applied (provided that all value inputs were cor-

rect). If you have activated the Close window after creation checkbox, the input window will be closed after gen-
eration of the sheet.
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Please note:

Incorrect inputs will be marked with a symbol. If you move the cursor over the symbol, an error description will
be displayed.

If the function cannot be executed due to incorrect value inputs, a symbol will be displayed on the OK button. If
youmove the cursor over the symbol, an error description will be displayed.

Editor for allowance methods
For the creation and/or editing of the files you use the ABWEditor tool in the EXE directory of your HiCAD install-
ation.

In the left column (1) of the Editor you can see the names of the ABW files that are stored in the corresponding
HiCAD system directory (../MAKROABW). Only the files stored in this folder will be recognized by HiCAD as avail-
able allowance methods and offered for selection in the corresponding dialogue.

When you click on an allowance method in the list, the content of the file will be shown in tabular form on the right
hand side (2) of the Editor.

This format-bound table has 4 columns and interval limits of 999.000. For method F (5) only 2 columns are relevant.
For all other methods, all 4 columns are relevant.

The columns have the following meaning for the allowance method:

Column 1 Interval for included sheet thickness

Column 2 Included bend angles

Column 3 Included inner radiuses

Column 4 Correction summand inmm (normally < 0)

Click the column headers to sort the column contents in ascending or descending order. The records of an ABW file
must have a particular order, which will be automatically applied upon saving. You can click the Sort data records

icon to restore the correct sorting order. The Copy data record function inserts a marked table row once
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more. If a sorting of the table has already been done, this new row will be inserted as the next row; otherwise, it will
be inserted as the last row.

The displayed File name (3) can be overwritten, as well as the individual numbers in the data records. The Type of
allowance method (5) can also be edited. The following types have currently been implemented:

F Factor
Method, e.g.
DIN6935

F determines the stretched length across the neutral fibre, which is corrected in the dir-
ection of the arc interior for small radii. Factor 1means an arc length on the neutral
fibre, while factor 0 reflects the arc length on the interior.

Z The Standard
Allowance
Methods with
External Refer-
ence Lengths,
e.g.
Heuschen,
also Dubbel

Z is the most frequently usedmethod. The reference lengths for an obtuse angle are
the imaginary intersection points of the sides on the flange exterior; in the case of
acute angles, the reference dimension is formed via the tangent perpendicular to the
dimension direction. This corresponds to the practical measurement of a workpiece
using the calliper gauge. The stretched length is then the sum of the lengths determ-
ined in this way plus the allowance values per bend.

I A Modified
Allowance
Method with
Internal Refer-
ence Lengths,
e.g. Kaiser

I is similar to Z, the difference being that it is not the exterior, but the interiors of the
sides that define the reference lengths. The practical significance of this method is
that the user often sets all allowances to zero and obtains a simple method with
acceptable calculation results for appropriate bend radii.

H A Modified
Allowance
Method with
Interpolation,
e.g. Haem-
merle

H is similar to Z, with two modifications: First, the intersection points of the sides
bound the reference line here even for angles above 90 degrees. Second, the allow-
ance value is interpolated linearly in the interval of the angles.

Polyhedral
Developments

The above explanations apply only to genuine sheet developments, but not to poly-
hedral developments. In these cases, only the existing surfaces are transformed to the
plane if INT/thickness = 1000. If a thickness <1000 is specified, the stretched length
resulting from the geometric middle of the specified imaginary thickness is shortened.

The Comment (4) can be edited on the second tab of the dialogue.

The comment in the ABW files that are supplied with HiCAD consists of a description of the method and the mean-
ing of the individual columns.
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The two cogwheels next to the file name indicate that this is a system file, i.e. an ABW file that is stored in the
HiCAD system directory.

If you want to load a different file (e.g. by clicking a different system file in the list or by creating a new file) you will
be asked whether you want to save the changes to the current file.

In the top right corner of the Editor (6) you can find the following icons:

Save Use this function to save the current file to its default storage location.

Save
as...

Use this function to save the current file to a storage location of your choice.

Save as
system
file

Use this function to save the file as a system file. This function is particularly relevant for
files the storage location of which is not the system folder for ABW files, or for new files.

Restore If youmodify a system file and save it with its current file name, the ABWEditor will create
a copy of the original file in the background. This function will then be active, i.e. not
greyed out. You can then use this function to restore the original version of the file.

With the help of the icons (7) at the top left you canmanage the ABW files:

Open
file

Use this function to open an ABW file which is not located in the HiCAD system folder
(../MAKROABW).

New file This function creates a new, user-speific ABW file.

Delete
file

This function deletes the current ABW file after a security prompt.

Unprocessed and processed sheets
One distinguishes between sheets with identical cross-sections (unprocessed sheets) and processed sheets.

n As "cross-sectionally identical" (unprocessed) are considered all sheets with at least one bend zone, parallel
front edges of the flanges (width of flange) and without any further processings such as bores, subtractions etc.
For these sheets, no drawing is normally required, but only a BOM.

n All other sheets are considered non-identical and processed. For these sheets a drawing is required.
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Production drawings for sheets with identical cross-sections

The output of cross-sectionally identical sheets can now be suppressed in the workshop drawing. To do this, open
the Configuration Editor, go to Sheet Metal and activate the checkbox for the parameter Suppress production
drawings for sheets with identical cross-sections.... The checkbox is deactivated by default.

Example:
The model drawing shown below contains 5 aluminium sheets. The sheets 5001 and 5002 have different
depths, but the same cross-sections and are unprocessed. This does not apply to sheet 5000, which has a pro-
cessing in the form of a material subtraction. Likewise, sheet 5003 is unprocessed, and sheet 5004 has a pro-
cessing in the form of a subtraction.

If the Suppress production drawings for sheets with identical cross-sections... checkbox has been activated,
only the sheets 5000 and 5004 will be considered for drawing derivations.
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Steel Engineering BOM (Excel) - Distinguishing unprocessed and processed

To be able to distinguish between unprocessed and processed sheets in the BOM, the following settings are
required:

1. In the Configuration Editor at Sheet Metal, the Special handling of sheets with identical cross-sections check-
box must be active (default).

2. The new template HiCAD_Stahlbau.2201.0must have been selected for BOM creation.

An additional Excel sheet will then be created for unprocessed sheets.

CAM data for unprocessed sheets

In the Configuration Editor at PDM > Management + BIM > External production drawings > CAM data for unpro-
cessed sheets you can specify whether the "unprocessed" sheets are to be considered for the creation of the CAM
data or not.

Sheet development

Auxiliary text with leader line

The Auxiliary text - Positioning setting in the Create sheet development now offers the additional Outside, with
line option.

If you choose Inside or Outside, the dimensions and the article number and, in some cases, the item number, will
be displayed by default. The text will be composed of the part attributes of the Sheet Metal main part. If you choose
Text with leader line, the text will be applied as a tag with a leader line.

Apply sheet development immediately

To achieve a after sheet development, the dialogue window now offers the new Apply immediately checkbox. If
you have activated the checkbox , the development will be immediately created after specifying the fitting point
in the drawing. Clicking the Apply button will no longer be necessary.
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Export sheet development as DXF file

Due to the switching to the new 3-D development (Version 2200) the valid development parameters of the model
drawing will be used when performing exports with the functions of the DXF: Complete menu.

The development parameters, e.g.

n Powder marking lines

n Bend lines

n Bend zones

n Bend radius

n Tool info

n Dimensioning

n Processing direction symbol

can be specified with the Default setting function (Sheet Metal > Sheet development > Update > ...).

Process development with 3-D functions

The 3-D processing functions for sheet developments can be accessed by right-clicking on the development and
choosing Process development.

The processings will be recorded in the Feature log and can be changed there. Changed edge parameters will be
recorded in the Appearance feature.
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Coating according to NCS
Use the Coating function to define the type (outer side, inner side, edge) , the colour and the description of a coat-
ing.

Besides the RAL colours and the system colours you can now also choose NCS colour codes from the catalogue for
coating colours.

The Natural Colour System (NCS) is a standardized colour system based on the human perception of colours. Cur-
rently it comprises 1950 colours that are arranged logically according to their tone and saturation. All colours that
are listed in the NCS system as theoretical values can also be created in practice. They are designated by means of
a combination of numbers and letters.
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Major Release 2017 (V 2200)

3-D development
The new functionality for creating and processing of 3-D developments replaces the 2-D development function that
was available until HiCAD 2016.

Develop sheet

The Develop sheet pull-down menu in the Sheet development function group provides various functions for devel-
oping of Sheet Metal parts.

Use this function to create the 3-D development of a Sheet Metal part. You can choose between an automatic align-
ment of the sheet or an alignment via edges.

You can derive several developments with different parameter settings from one Sheet Metal part. The parameter
settings will be saved with the development. For each development a new view will be created. The view and the
Sheet Metal part are linked to each other. If the Sheet Metal part is deleted, the view of the development will also
disappear.

You have the option to specify the development parameters during creation of the development. The functions for
the changing of the parameters can be found at Sheet Metal > Sheet development > Update > .... When you
call the function, the following dialogue window will be displayed:

Create sheet development dialogue window
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Automatic

To determine the alignment of the sheet automatically, click this icon at the top of the Create sheet devel-
opment dialogue window. 

After identifying the sheet, a transparent preview of the 3-D development will be shown at the cursor. The options
for the selection of direction and upper side (Direction symbol, Coated side, ...) can be changed by activating or
deactivating the corresponding checkboxes. The priority results from the ascending order of the active options. If
the upper side is determined by the coating or the number of powder marking lines and letterings, the alignment will
be horizontally to the longest edge or bend line, respectively.

Manual

To determine the alignment of the sheet via manual selection of an edge bordering on a top facet, click this icon

at the top of the Create sheet development dialogue window. Then, identify the edge.

After identifying the sheet, a transparent preview of the 3-D development will be shown at the cursor. The identified
edge determines the upper side and will be aligned horizontally in the development. Specify an insertion point for
the development in your drawing.

Upper side and alignment are determined by the identified edge.

104 / 294 What's new?

Sheet Metal



Development parameters

The following functions for the determining of development parameters are available:

Use this function to change the parameters of the chosen development.

Use this function to change the parameters of all developments and the pre-setting in the drawing.

Use this function to change the pre-setting of the parameter for new developments in the drawing.
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Representation

The Bend lines and Bend zones beneath Representation can be activated or deactivated. Length, distance to

outer contour, line type and colour can be specified in the Extended settings on the Bend lines tab. Positive
and negative bend lines can be configured separately.

Activate the Subordinate parts checkbox if you also want to show parts that are subordinated to a flange (e.g. wel-
ded nuts, 3-D parts).

Dimensioning

If you activate the Dimension checkbox, only the greatest extension in X- and Y-direction will be dimensioned.

If you activate the Outer contour checkbox, the complete contour will be dimensioned.

If you activate the Bend lines checkbox, the bend lines running parallel to the outer contour will be dimensioned,
independent of the other dimensioning settings.

Annotation

Here you can configure annotations for developments (bend lines, cross-breaks, punchings). Also, you can define
additional texts, e.g. for the production. You can either define the texts manually, with the help of the Annotation

Editor, or load the annotations for Bystronic or LVD via the Favourites .

To start the Annotation Editor, click the icon next to the option. For each annotation, the attributes for eval-
uation will be displayed. These can also be supplemented by additional, user-defined comments. You can assign to
each text block the properties Font, Character set, Font size, Line spacing, Font colour, Aspect ratio/Inclination
(only for HiCAD fonts) and the orientation of the text (left, centred, right).

Favourites

The settings of the dialogue window can be saved as favourites and re-used at any time. To do this, click on the

symbol at the bottom left of the window.

The settings for LVD, Bystronic and Lantek Expert have been predefined and saved as favourites.

More information on Favourites Management can be found in the Manage Favourites topic of the HiCAD Basics
Help.

Favourites can be loaded as default settings for new drawings in the Configuration Editor at Sheet Metal > Sheet
development > Default setting.

Apply/discard settings

After entering all required data you have the following options: If you choose Apply the development will be inserted
into your drawing, but the dialogue window will remain open, allowing you to make adjustments if required. If you
choose OK, the development will be inserted and the window will be closed. If you choose Cancel, the window will
be closed and the specified settings will be discarded. Click Preview to update the development after making
changes to the settings in the dialogue. For this to happen, the development must have been placed in the drawing.
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Example

(1) Bend radius and bend angle with different font parameters

(2) Different colours for interrupted bend lines and bend zones

(3) Dimension

(4) Cross-break with red height and black angle

(5) Punch with tool number

Update

The processing functions for 3-D sheet developments can be activated with a right-click on the development.

Suppress
sheet
update

Use this function to lock the sheet development against changes on the sheet,
i.e. any changes that are applied to the sheet will not be taken over into the sheet
development.

Allow sheet
update

Use this function to deactivate the locking of the sheet development against
changes on the sheet. Changes to the sheet will be taken over into the sheet devel-
opment again.

Update
development

Use this function to take changes to the sheet over into the sheet development.

Change
development

Use this function to call the Development parameters. A preview of the changes
will be shown when you click the Preview button. Click OK to apply the changes.

Delete Use this function to delete the development.
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Export

The Sheet development function group contains the Extras menu with various management functions. Here you
will find the following export functions for section contours and developments:

Function Description

Export section contours of devel-
opment as DXF file

Exports the section contour of a development.

Extras

All developments (DXF: Section
contours)

Generates a section contour from all developments and
exports them, provided that they are:

n BOM-relevant and

n have an item number.

The current pre-settings for the drawing will be used for gen-
eration.

All sheets (DXF: Section con-
tours)

Generates a section contour from all sheets and exports
them.

The current pre-settings for the drawing will be used for gen-
eration.

Sheets from list (DXF: Section
contours)

Generates section contours from selected sheets and exports
them.

The current pre-settings for the drawing will be used for gen-
eration.

Development (DXF: Complete) Exports the sheet development of a development.

All developments (DXF: Com-
plete)

Generates an export file from all developments, provided that
they are:

n BOM-relevant and

n have an item number.

The development parameters of the drawing will be evaluated
for the generation.

All sheets (DXF: Complete) Generates developments of all sheets and exports them.

The development parameters of the drawing will be evaluated
for the generation.

Sheets from list (DXF: Complete) Generates developments of selected sheets and exports
them.

The development parameters of the drawing will be evaluated
for the generation.

Old functions for 2-D developments

The functions for the processing of old 2-D developments that could be created with HiCAD up to Version 2016 can
finden Sie unter Sheet Metal > Sheet development > Update > Up to HiCAD 2016 > .... From HiCAD 2017
onwards, only 3-D developments can be created.
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"Clone feature" for "Attach flange" function
The Attach flange function can now be cloned via the feature log by means of the Clone feature function. This
means that you can now execute the Attach flange function multiple times as a "pattern" with the help of HiCAD's
Feature Technology.

When you call the function the following dialogue window will be displayed:

Available are the pattern types Linear , Rotatory , Along polyline or Linear+Rotatory for the
cloning of the Attach flange function. If desired, you can also combine several patterns in a row.

If you want to exclude any particular clonings, you can delete them in the Omissions area.
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Rotation axis = Centroid of base sheet; 5 clonings; Individual angle 60°, Individual distance 0

Without allowance method
If you have not chosen an allowance method during the creation of new sheets or the attaching of flanges, this will
be indicated by a corresponding entry in the feature log. You can double-click this entry to open a window allowing
you to select an allowance method.
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Tear-open edge in analytical development
You have now the option to change the Layer, the Colour and the Line type of tear-open edges when using the Sur-
face ... (analytical) development functions. This can be useful, for example, if you want to create a temporary
development to calculate costs for pipe machinings.

You change the parameters of the tear-open edge in the system file ABWCOL.DAT. If you remove the "minus" pre-
ceding the parameters, the Layer, the Colour and the Line type will be evaluated.

Kant eneigenschaf t en f ü r Au f r e ißkan t en beim ana l yt i schen Abwickeln ; Sch ich t ( 0-999) , Fa r be( 0-9 ) , S t ä r ke
( 0-9 ) , A r t ( 0 -9 ) ; < 0 :Kant eneigenschaf t en von Auf r eißkan t en wer den n ich t geset zt [ Edge p r oper t i es f or
t ea r -open edges dur ing ana l yt i ca l development ; Layer ( 0 -999) , C olou r ( 0-9 ) , Weigh t ( 0-9 ) , Type( 0-9 ) ; <
0 :Edge p r oper t i es of t ea r -open edges not set ]

1711

Example

In this example the tear-open edge is green
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"Drawing" tab changed
n The functions for the detail drawings of selected Steel Engineering parts can now be found at Drawing >

Itemisation/Detailing > Derive >Detail drawing - ... .

n At Drawing > Itemisation/Detailing > Attr. you will now find the following functions:

Edit part annotation templates

Templates, Attribute assignment

Article master, Itemisation

Document master, Detail drawing

n At Drawing > Itemisation/Detailing > Dim. you will find the following functions:

Edit dimensioning rules

Dimensioning Settings

These functions were previously available on the Steel Engineering tab at Further functions > Settings > ... .
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Composite panels as semi-finished products
Composite panels are now available as semi-finished products in the Catalogue Editor.

These composite panel consist of two 0,5 mm aluminium cover sheets with a mineral core. In HiCAD the plate is
represented simplified as a one-layer sheet. Since the weight calculation is done based on a homogeneous mater-
ial, an ownmaterial is assigned to the panel.

The file ACP.ABW is used for the allowance method. In exceptional cases, for bent sheets with outside millings, you
can use the allowance method ACP_outside.ABW instead.

Bend radius (BRAD): 0.01 (Standard, for inside millings)

Bend radius, milled outside (BRAD_OUT): 1.50 (Exception, for outside millings)

(1) Milled, inside

(2) Milled, outside

In the Catalogue Editor you can find the composite panels at Factory standards > Sheets.
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Steel Engineering

Service Pack 2 2017 (V 2202)

Grids

Manual annotation for grid sub-systems

Besides the automatic annotation for grid sub-systems in derived drawings you have now the additional option to
annotate the grid sub-systems manually. To do this, choose Steel Engineering > Further functions > Settings

> Grid annotation - Individual .

After calling the function, select the edge of the grid sub-system. The annotation will be created immediately. The
settings specified at Drawing > Annotations > Grid annotation will be considered for its representation.

Please note:

n The article number of the grid sub-system will only be written into the text box of the annotation tag, if in the Con-
figuration Editor, at Drawing > Annotations > Grid annotation, the Show name checkbox has been activated.

n When annotating the sub-systems manually, a designating of connecting points with symbols is not possible.

n If you choose a different edge or two points instead of the edge of a grid sub-system, an annotation tag of the
grid plane will be created.

Use the functions of the context menu to edit and move the annotations. You open the context menu with a right-
click on an annotation:

When editing manually created annotations of grid sub-systems, please note that the settings beneath Symbol only
apply to automatically created annotations!

The setting options in the dialogue window correspond to the same-named parameters in the Configuration Editor.
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Timber construction

Design Variants for timber construction

HiCAD now also offers Design Variants for the following timber constructions:

n Front joint,

n Front+heel joint,

n Straight scarf,

n Oblique scarf (scarf joint).

These Design variants can be found in the Civil Engineering functions docking window at Timber construction.
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(1) Front joint, (2) Front+heel joint, (3) Straight scarf, (4) Oblique scarf (scarf joint)

Mounting drawings

Mounting drawings - Rearranging views when updating

After opening the Update mounting drawing function you have the option to decide whether the views in the
mounting drawing should be rearranged after updating (if necessary) or not. To do so the following dialogue window
will be displayed:

If the views of the active sheets should not be rearranged, for example to preserve previous manual rearranging of
views, select No.

For mounting drawings which have been created with the Management + BIM functions, the rearranging of views
after updating the drawing will be determined in the Configuration Editor. Via PDM > Management + BIM > Pro-
duction drawings you can find the Rearrange views when updating production drawings parameter.

Fit DIN frame

If you choose the Fit DIN frame option while a sheet contains only one view group, the frame size will always be
recalculated when the drawing sheet is updated.

Optimised performance when calculating boxes of a mounting drawing

The performance of the calculation of transparent preview boxes for view groups in a mounting drawing has been
greatly improved.
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Production drawings

Assembly points

Assembly points will now always be hidden in the derivation of production drawings.

Settings for sectional views of sheets

New in the Drawing derivation dialogue window is the Sectional views for sheets button. Click this button if you
want to specify the settings for sectional views of Sheet Metal parts.

The following settings are possible:

n Scale of sectional views

n Angular dimensions in sections
Use this parameter to determine whether angular dimensions are to be created in sectional views or not.

n Offset go-side
Fore coated sheets, use this parameter to specify the distance of the projection line for the go-side.
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Example: Workshop drawing of a coated sheet

New and enhanced dimensioning rules

Rules for sectional views

For sectional views in production drawings, new and enhanced dimensioning rules are available for beams which
are attached parts.

The following rules are new:

146 PROFILE_LENGTH_IN_SECT

Length of beam sub-parts in sectional views

Recommended settings
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147 PROFILE_WIDTH_IN_SECT

Width of beam sub-parts in sectional views

Recommended settings

148 PROFILE_HEIGHT_IN_SECT

Height of beam sub-parts in sectional views

Recommended settings
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Example: Rule 146-148
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149 PROFBORES_IN_SECT

Bores of beam sub-parts in sectional views

Recommended settings:
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Example: Rule 149

150  PROF_POSITION_IN_SECT

Position of beam sub-part in sectional views
(determined by one bore or outer edge and the reference part)

Recommended settings:
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Example: Rule 150
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The following rules had only been available for attached parts in Sheet Metal before but can now be used for
beams, too.

53  BORE_DIAMETER_IN_SECT

Diameter of simple bores in sheets/plates (sub-parts) in sectional views

Recommended settings

54  NORMBORE_DIAMETER_IN_SECT

Diameter of standard part bores in sheets/plates (sub-parts) in sectional views

Recommended settings

55 CONNECTION_DIAMETER_IN_SECT

Durchmesser von Verschraubungen in Blechnebenteilen in Schnittansichten

Recommended settings
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Example Rule 53 and 54

Dimensioning of processings depending on position to beam axis

Processings on beams can be dimensioned depending on the position to the beam axis. In the process it is irrel-
evant whether the processings (bores) have been created by inserting a bore pattern or individual bores.

The following rules are new:

151 PROFBORES_ INUPPERFLANGE_ SEPERATED
Bores in upper flange of beam, separated by position with regard to beam axis

Recommended settings:

152 PROFBORES_INLOWERFLANGE_SEPERATED

Bores in web of beam, separated by position with regard to beam axis

What's new? 125 / 294

News Overview



Recommended settings: See above

153 PROFBORES_INWEB_SEPERATED

Bores in web of beam, separated by position with regard to beam axis

Recommended settings: See above

Rules 151, 152 and 153 only apply for dimensioning parallel to the beam axis, since other separation mechanisms
exist for dimensionings perpendicular to the beam axis. Only bores that are located in the view plane will be con-
sidered.

If Position of dimension chain: Automatic has been selected, the chains will be pulled out upwards or downwards,
depending on the position of bores.

Rules 151 - 153, Example: (1) Front view, (2) Top view

Distinguishing of hidden / unhidden sub-parts

In the file STW_DIMSETTINGS.XML you can specify how base points on hidden parts are to be handled when using
dimensioning rules. To do this, enter the following string into the file:

</PARAM><PARAM Name="IGNOREHIDDENSUBPARTANDBORES" Typ="INT" Value="0">

If Value has been set to 1, base points that are located on hidden sub-parts will not be considered for dimensioning
in all dimensioning rules.

Connections

Cam joint (2104)

Analogous to Sheet Metal, it is now possible to insert cam joints for Steel Engineering plates quickly and con-
veniently. The respective design variant for Steel Engineering plates can be found in the Civil Engineering func-
tions docking window under Steel Engineering > General.
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First select the outer edge of the first Steel Engineering plate for the cam joint and then the surface of the second
Steel Engineering for the subtraction.

Afterwards, enter the desired parameters in the Cam Joint (2104) dialogue window.

Example:

The two displayed Steel Engineering plates shall be connected. To do so, the outer edge (1) of the first plate will be
selected as well as the surface (2) of the second plate.
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(a): Corner processing 1st and 2nd plate: subtract rectangle

(b) Corner processing 1st plate: none, 2nd plate: slot shape

(c) Corner processing 1st and 2nd plate: Bore out
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Column connection, Frame corner (2203)

The dialogue window for the Column connection, Frame corner (2203) Design Variant has been modified and
enhanced.

n The haunch can now be subdivided into several segments, i.e. it can consist of up to 3 haunched plates. To do
this, enter the required number of segments and their width, and choose the required semi-finished product.

n The settings for additional stiffeners on the column and the ribs on the transom have been separated.

(1) Parameters for stiffeners, (2) Parameters for ribs
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Stairs and Railings

Concrete stairs

The dialogue for creating concrete stairs has been revised and now provides the option to create concrete stairs
according to DIN.

n Instead of the number of stairs the total number of rises is entered.

n The length of the staircase can either be measured in stair direction or horizontally, i.e. the horizontal length
between the first and the last step.

n The thickness of stairs can either apply to

l the Direction of stairs (Minimum)

l the Direction of stairs (Maximum) or

l the vertical direction.

The following image shows concrete stairs with 8 rises and the different staircase parameters.
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(1) width, (2) height, (3a) length of the stair direction, (3b) horizontal length, (4) angle, (5) podium length, (6) podium thick-

ness, (7a) thickness in direction of stairs (minimum), 7(b) thickness in direction of stairs (maximum), 7(c) thickness in vertical

direction)

Vertical rods

For vertical rods with booms you can now you can now specify whether the booms on the posts and the filling rods
on the booms are to be trimmed.
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Input options for vertical rods with beams

Vertical rods with booms - untrimmed (left) and trimmed (right)
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Railings with individual post distribution

The post distribution can also take place manually, i.e. with different distances between the individual posts. For
this purpose the Post distribution tab has been expanded accordingly.

When you click the button, the settings that were last specified on the Post distribution tab of the dialogue window
will be displayed as defaults for individual post distribution. This includes the definition of the distances at the start
and the end of the walking line, the corner distance and the transition distance with concrete values. Therefore, the
Individual option is initially greyed out. The settings can then be modified as described below.

After a click on the button the Individual option will be available. You can then (while the dia-
logue is open) switch between the other options beneath Distribution of posts and the individual distribution.
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Left: Last settings; Right: Individual post distribution after clicking
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If you activate the Auto checkbox, all distances will be recalculated. If you want to define individual distances,
deactivate the corresponding Auto checkbox and enter the required distance. All distances with an active check-
box will continue to be calculated automatically.

When you move the cursor over the entries for the posts, the corresponding post will be highlighted in green in the
drawing. Distances between posts are highlighted in red, all other distances in blue.
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In the post distribution list you can also add new posts and distances with the help of functions the icons of which
become visible when youmove the cursor over the Segment, Distance and Post rows.

The meaning of the symbols:

Segment

New distance at start of segment

Adds a new auto-distance at the start of the segment. All other distances with active
Auto checkbox will be recalculated.

New post at start of segment
Adds a new post at the start of the segment.

New post, via point
Allows the insertion of a new post at a defined point.

Distance

New post
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Adds a new post after the current distance.

Delete distance

Post

Move post, via point

Moves the current post to a defined point. Specify the point on the segment.

New distance

Inserts a new auto-distance after the current post. All other distances with active Auto
checkbox will be recalculated.

Delete post

The Distance and Post rows can be moved by Drag & Drop.

If the post distribution cannot be applied with the specified data, e.g.

n because no distance between 2 posts has been defined, or

n because a post would be located outside the segment due to the entered data,

this will be indicated accordingly on the OK and Preview buttons by the symbol, and in the post distribution sec-
tion by the symbol. If you move the cursor over the symbols, a short explanation of the error will be displayed,
e.g.:
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Service Pack 1 2017 (V 2201)

Insertion of beams and profiles

Beams/profiles from sketches

When you choose the functions

Multi-part beam from sketch and

Beam from sketch

you can now also use the Insert along c-edge option. This allows a placing of simple beams or multi-part beams
derived from a sketch along composite edges consisting of straight lines and circular arcs.

The beam (3) was derived from a sketch (1) and inserted along a c-edge (2)
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Production drawings

Placing of annotations

Annotations for beams, plates and sheets in workshop drawings can be applied with or without leader lines. This
can be adjusted in the Configuration Editor under Automatic drawing derivation > Production drawing > Annota-
tions > Placing of annotations. The checkboxes are activated by default. This means that the annotations are
placed direction on the sheet or beam. If there is not enough space to do so, the annotations will be done with
leader lines.

If the checkboxes are deactivated, the annotations are categorically produced with leader lines.
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Suppress sheets with identical cross-section

Sheet metal is distinguished between sheets with identical cross-sections (unprocessed) and processed sheets.

l Unprocessed sheets with identical cross-sections are characterised by at least one bend zone, parallel
front edges of the flanges (width of flange) and no further processing, e.g. subtractions, bores etc. For
these sheets a drawing is not necessary, only a BOM.

l All other sheets count as unalike and processed. These sheets require drawings.

The output of sheet metal parts with identical cross-sections can be suppressed in the workshop drawing. To do so,
the Suppress production drawings for sheets with identical cross-sections when deriving drawing checkbox
has to be activated in the Configuration Editor under Sheet Metal.

Example

The displayed drawing contains 5 aluminium sheets. Sheet 5001 and 5002 have different sheet depths, but they
have identical cross-sections and are unprocessed. This does not apply to sheet 5000 as it has a subtraction, thus it
is processed. Analogous to that, sheet 5003 is unprocessed and sheet 5004 is processed due to the subtraction.

If the Suppress production drawings for sheets with identical cross-sections when deriving drawing checkbox
is active, only sheet 5000 and sheet 5004 will be considered in the drawing derivation.
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Drawing frames for output of assemblies with main and sub-parts

When generating production drawings with the options

n Sheet selection:
New sheet for each assembly,

n Drawing parameters:
From configuration,

n View groups to be created for:
Main parts as assembly

Main parts, individually

Sub-parts, individually,

the drawing frames assigned to each assembly will be used. Up until now this has only been the case if only the
assembly (main parts as assembly) has been detailed in the drawing.

An example:

The drawing contains the following parts:

Object Usage-dependent settings Assigned drawing frame

Assembly with the usage: Girder (beam) assembly ASSEMBLY_BEAM DIN_A2

I-Beam (main part) DFEAULT(I_PROFILE) DIN_A4H_BLECHE

Plate (sub-part) DEFAULT(Bleche) DIN_A4H_PROFILE
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If the production drawing is now be created as follows,

the drawing frame of the production drawing will be DIN_A2.
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Default Configurations for assemblies without usage

For assemblies which do not have an assigned usage it is now also possible to define default configurations (usage-
dependent settings) for the creation of detail drawings (production drawing for a view group). In the Configuration
Editor via Automatic drawing derivation > Production drawing > Usage assignment, the selection of part types
has been expanded.

The configurations need to have the following names:

Assembly type Name of the default configuration

All assemblies DEFAULT(ASSEMBLY)

Assembly DEFAULT(COMMON_ASSEMBLY)

Welded assembly (Workshop) DEFAULT(WELD_ASSEMBLY)

Bolted assembly (Site) DEFAULT(MOUNTING_ASSEMBLY)

Glazing assembly DEFAULT(GLAZING_ASSEMBLY)

Mullion assembly DEFAULT(MULLION_ASSEMBLY)

Transom assembly DEFAULT(TRANSOM_ASSEMBLY)

Glass assembly DEFAULT(GLASS_ASSEMBLY)

Insert assembly DEFAULT(INSERT_ASSEMBLY)

Planning grid DEFAULT(PLANNINGGRID_ASSEMBLY)

Structure assembly DEFAULT(STRUCTURE_ASSEMBLY)
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When creating a detail drawing (drawing parameters from configuration) for an assembly without assigned usage,
HiCAD will check whether a default configuration is available for the respective assembly type. If this is not the
case, the DEFAULT configuration will be used.

Sheet development

in HiCAD 2017 (2200.0) the 2-D development which has been valid up until HiCAD 2016 has been replaced by a
new function for creating and modifying 3-D developments. This also affects the settings for sheet development in
workshop drawings.
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Avoiding multiple sectional views

You can now specify in the Configuration Editor at Automatic drawing derivation > Production drawing that sec-
tional views with the same content in the workshop drawing are to be created only once. For this to happen, activ-
ate the Avoid multiple sectional views checkbox.

Sectional views are interpreted as "equal", if

n the visible (displayed) parts in the sectional views have the same valid item numbers and

n the sectional views contain the same geometries.

Sectional views for sheets beyond the beam end (front plate, top plate, base plate meaning the same) are generally
different.

Structured display of dimensioning rules in Editor

In the Dimensioning Rule Editor the dimensioning rules are now displayed in groups for a clearer selection.

If not all groups are to be shown it is also possible to modify the display by selecting one group in the list box on the
side.
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New dimensioning rules

n New dimensioning rules are at disposal for dimensioning attached parts via bores (if desired and available) or
via the outer edges of the attached part. For attached parts located before or behind - or above and below - the
axis of the main part, a chain of dimensions will be created.

Rule Internal designation

138 Attached parts via bores (also perpendicular to view) or outer con-
tours, located before the axis of the main part

ATTACHING_PARTS_
VERT_BEFORE_AXIS

139 Attached parts via bores (also perpendicular to view) or outer con-
tours, located behind the axis of the main part

ATTACHING_PARTS_
VERT_BEHIND_AXIS

140 Attached parts via bores (also perpendicular to view) or outer con-
tours, located above the axis of the main part

ATTACHING_PARTS_
VERT_ABOVE_AXIS

141 Attached parts via bores (also perpendicular to view) or outer con-
tours, located below the axis of the main part

ATTACHING_PARTS_
VERT_BELOW_AXIS

If no bores exist, dimensioning will take place via the outer contour. If bores exist and the dimensioning is still to
take place via the outer contour, open the Drawing tab and choose Itemisation/Detailing > Dim... > Dimen-
sioning Settings > Bores/Boltings > Chains of dimensions for sub-parts: Without bore(s).
An example:
The image below shows a beammain part and a plate with 2 bores as attached part (1). In the configuration the
Dimensioning rule 138 has been applied as shown below (2). (3) and (4) show the front view in the workshop
drawing. In (3) the attached parts are dimensioned via bores, in (4) via the outer contour.
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n Processings at the girder/sheet should often be dimensioned with regard to the location of the processing. This
means that when the chain of dimensions should be aligned parallel to the axis, its position is guided by the pos-
ition of the girder's axis. If the chain of dimensions is to be aligned perpendicularly, the chain of dimensions is
oriented to the middle of the girder.

For sheets and plates this is already given by the following dimensioning rules:

Rule Internal designation

32 Bores in sheets/plates, right side SHEETBORES_RIGHT

33 Bores in sheets/plates, left side SHEETBORES_LEFT

35 Bores in sheets/plates, upper half SHEETBORES_ABOVE

36 Bores in sheets/plates, lower half SHEETBORES_BELOW

38 Outer contour of sheet/plate, right side SHEETOUTLINE_RIGHT

39 Outer contour of sheet/plate, left side SHEETOUTLINE_LEFT

40 Outer contour of sheet/plate, right or left side SHEETOUTLINE_RIGHTANDLEFT

41 Outer contour of sheet/plate, upper half SHEETOUTLINE_ABOVE

42 Outer contour of sheet/plate, lower half SHEETOUTLINE_BELOW

For beams the following rules are now available:

Rule Internal designation

142 Beam processings, located in front of the axis of the
main part

PROFBORES_ BEFORE_
AXIS

143 Beam processings, located behind the axis of the main
part

PROFBORES_ BEHIND_
AXIS

144 Beam processings, located above the axis of the main
part

PROFBORES_ ABOVE_
AXIS

145 Beam processings, located below the axis of the main
part

PROFBORES_ BELOW_
AXIS

These rules create separate chains of dimensions depending on the position of the processing with regard to
the beam axis. If perpendicular dimensions should be extended to the left or right depending on the processing
regarding the beammiddle, this can be done by selecting Position:Automatic.
The image below shows a hollow profile with 4 bores: (1) Bore through front side, (2) Bore through rear side, (3)
Bore above profile axis, completely through, (4) Bore below profile axis, completely through. For the front view
of the workshop drawing the new new dimensioning rule 142 to 144 have been used.
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Deleted dimensions when updating

Deleted dimensions when updating

Deleted dimensions when updating

If an automatically generated dimension, i.e. a dimension based on dimensioning rules, is deleted in one view of
the workshop drawing, this dimension will not re-appear when updating the workshop drawing!

More specifically the procedure will be as follows as of HiCAD 2017 SP1:

n The selected dimension will be deleted and will not re-appear when updating the drawing.

n The dimensioning rules set saved in the workshop drawing data for the view groups of the selected dimension
will be adjusted so that the dimensioning rule for that dimension will be omitted in the respective direction and
view. HiCAD will point this out by showing the following message:

If this message should no longer be displayed during the current HiCAD session, please activate the Suppress mes-
sage checkbox.

n All other dimensions of the view which were created with the same dimensioning rule and in the same direction
as the deleted dimension will be transformed into interactive dimension and remain when the drawing is
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updated.

If you do not want this behaviour you have the possibility to turn it off in the Configuration Editor under System set-
tings > Annotations > Dimensioning, 3-D by deactivating the Rework when deleting workshop drawing dimen-
sions checkbox. This is recommendable if a loss of performance can be noted in workshop drawings with many
views.

The new behaviour only works with workshop drawings which were created or updated in HiCAD
2017 SP1!

Designation tags for sub-parts on back, bores and boltings

You now have the opportunity to select that the designation tags of sub-parts, bores and boltings on the back

should not be displayed. For this purpose the Dimensioning Settings function has been expanded respect-
ively.

In the Designation tag dialogue window the checkbox next to the respective selection box for line types determines
whether the designation tags of sub-parts, bores and bolting on back should be displayed or not. This checkbox is
activated by default, i.e. the designation tags will be displayed.

The deactivation of the checkbox for bores is e.g. useful in the hidden line mode, because in this case the bores are
not visible and it does not make sense to label them.

This setting affects not only conventional dimensioning but also the dimensioning rules.
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Designation for identical processings /bores

If the Specify number of bores checkbox is activated in the Designation Settings under Designation tags,
bores which are the same but do not belong to the same bore pattern will be combined.

However, this will only apply under the following conditions:

n The bores belong to one part.

n The bores lie on the same side of the main part.

n The bores have the same diameter.

n It is a single bore and not a bore pattern and

n ALL bores of the part meet these conditions.

Separate dimension chains for bores and subtractions

In the Dimensioning Settings it is now possible to determine under Bores/Boltings that separate chains of
dimensions should be created for bores (through holes and standard bores) and subtractions. For this purpose there
is the Separate dimension chains for bores and subtractions checkbox.

For new installations or when the dimensioning settings file STW_DIMSETTINGS.xml is not yet available, the stab3-
par.dat option can be switched on and off under

Maßket t en f ü r Lage der B oh r ungen / Ausnehmungen t r ennen nach Bohr ungen und Ausnehmungen 1 : ja , 0 :nein

If the STW_DIMSETTINGS.xml file is available, the line

</PARAM><PARAM Name="DEV IDEBORESANDCUTS" Typ="IN T" Va lue="1">

has to be added.

This settings will not yet be saved in the workshop drawing at this point!
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Example - Separate chains of dimensions for bores and subtractions

The depicted drawing (1) contains several through holes bores and one rectangular subtraction. (2) separate chains
of dimension, (3) one chain of dimensions for bores and subtractions

Please note that this setting also affects the following dimensioning rules:

12 Bores in web of beam   PROFBORES_INWEB

15 Bores in upper and lower flange of beam PROFBORES_INFLANGES

34 Bores in sheets/plates, right or left side SHEETBORES_RIGHTANDLEFT

37 Bores in sheets/plates, upper or lower half SHEETBORES_ABOVEANDBELOW

49 Outer contour of sheets/plates, right and left side, in sectional
views

SHEETOUTLINE_RIGHTANDLEFT_
IN_SECT

50 Outer contour of sheets/plates (sub-parts), top and bottom
side, in sectional views

SHEETOUTLINE_
ABOVEANDBELOW_IN_SECT

85 Beam processing in web, incl. processings in side view PROFBORES_INWEB_VERT

88 Beam processings in upper and lower flange, incl. processings
in side view

PROFBORES_INFLANGES_VERT

98 Bores in web of relevant beam sub-parts PROFBORES_INWEB_RELVPROFS

101 Bores in flanges of relevant beam sub-parts PROFBORES_INFLANGES_
RELVPROFS
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Separate dimensions according to part type for position of sub-parts

In the Dimensioning Settings it is now possible to determine under General that attached parts (beams) will
be dimensioned according to the Part type attribute in the different chains of dimensions. A respective checkbox is
available in the dialogue window. In this way it is possible to dimension hollow profiles / attached parts separately
from round steel / attached part, thus improving the dimension structure.

This setting affects dimensioning rules for chains of dimensioning of relevant parts.

For new installations or when the dimensioning settings file STW_DIMSETTINGS.xml is not yet available, the stab3-
par.dat option can be switched on and off under

Separ a t ed cha in d imensions accor d ing t o pa r t t ype f or posi t i on of sub-pa r t s 1 : yes, 0 :no - G et r enn t e Mass-
ket t en nach Tei l ea r t f uer E inbausi t ua t i on von Neben t ei l en 1 : ja , 0 :nein

If the STW_DIMSETTINGS.xml file is available, the line

</PARAM><PARAM Name="SEPERATEDSUBPARTPOS ITION_PT" Typ="IN T" Va lue="0">

has to be added.

Not considering connected elements in Metal Engineering

If a drawing contains connected elements which have been created with functions under Metal Engineering > 3-D
section, these will not be considered in the workshop drawing. This also applies if the parts are BOM-relevant.

Mounting drawings

Placing of annotations

The annotations of beams and sheets in workshop drawings can be made with or without leader lines. This can be
adjusted under Placing of annotations. The checkboxes are activated by default. This means that the annotations
are placed direction on the sheet or beam. If there is not enough space to do so, the annotations will be done with
leader lines.

If the checkboxes are deactivated, the annotations are categorically produced with leader lines.
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Connections / Design variants

New design variant - Column connection, Frame corner 2203

In the installation of frame corners the new design variant 2101 replaces the former variant 203.

With this variant two beams are connected with a bolted or welded beam frame corner. You can create the frame
corner with or without stiffeners, haunched plates or other components, e.g. flange plates, web reinforcements and
reinforcement plates or filler plates. It is also possible to insert ribs as additional stiffeners at the front plate and ten-
sion plate, and also weld seams as well as to apply galvanization holes.

Example - (1) tension plate, (2) front plate

Assignment of boltings

Boltings will be compromised under the name Bolting for various connections. If the assembly should not be a part
of the welded assemblies, i.e. if the Loose parts option is activated in the settings, the Bolting assembly - as well as
filler and reinforcement plates - will be assigned to the Loose part assembly.

This applies as of HiCAD 2017 SP1 for the following design variants:

n Base plate / Anchor plate (2101)

n End plate (2102)

n Purlin joint, 2 plates with mitre cut (2201)

n Front plate connection to web/flange (2320)

n Front plate connection to web, double-sided (2322)

n Front plate connection to flange (2330)

154 / 294 What's new?

Steel Engineering



Connections with filler plates

For all connections with filler plates the hole clearance now refers to the bolting and not to the bores.

(1) Bolt diameter, (2) Two-piece filler plate, (3) Hole clearance

This applies to the following connections:

n Base plate / Anchor plate (2101)

n End plate (2102)

n Purlin joint, 2 plates with mitre cut acc. to DAST-IH (2201)

n Front plate connection to web/flange (2320)

n Front plate connection to web, double-sided (2322)

n Front plate connection to flange (2330)

Horizontal / vertical switching of connection values

The following connections:

n Base plate / Anchor plate (2101)

n End plate (2102)

n Purlin joint, 2 plates with mitre cut acc. to DAST-IH (2201)

n Front plate connection to web/flange (2320)

n Front plate connection to web, double-sided (2322)

n Front plate connection to flange (2330)

n Beam to web with 2 plates + stiffener (1211)

allow a horizontal and vertical switching of values, i.e. the switching of right and left, and top and bottom. For
instance, this can be done for
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n Bore grid distances, grid references,

n Plate distances, plate references, or

n Other references.

To do this you use the two arrow symbols and .
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Railing Configurator

Types of usage for assembly main parts

A usage will now be automatically assigned to the main parts of the posts, handrails and skirting board assemblies.

Assembly
Type of Usage for
assembly

CONFIGKEY
Type of usage of main
part CONFIGKEY

Post Post POST Post profile POSTPROFILE

Handrail Handrail HANDRAIL Handrail profile HANDRAILPROFILE

Skirting
board

Skirting board SKIRTING Skirting board profile SKIRTINGPROFILE

Infill, glass element

When using Infill with glass elements the new usage type Filling was previously automatically assigned to the glass
elements. As a result, no production drawings were created for these elements, since in the FILLING configuration
the default setting for this usage is Perform drawing derivation = No.

From Version 2017 SP1 onwards, no usage will be assigned to glass panes. This enables you to use the DEFAULT
(GLASSCHEIBEN) configuration for the workshop drawing.

The usage FILLING will be assigned to the assembly of the infill.
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Posts - Handrails: All connections equal

In the settings for the connection of posts and handrails the option All connections equal checkbox is now avail-
able. This way it is possible to select the same setting for all posts with only one click.

Post connection, top - different distances for horizontal and oblique fixing

In the Post - Substructure tab you can now enter different distances for the horizontal or oblique fixing for Post con-
nection, top. This applies to all bore grids.

Before as of HiCAD 2017 SP1
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Post connection, lateral - different fixing heights for each section

Depending on the kind of the selected beams they will be divided into different sections. The first beam belongs to
section 1. HiCAD checks whether the next beam lies on the same plane. If so, it also belongs to section 1. If it does
not lie on the same plane, section 2 will start with this beam and so forth. For the lateral post connection the
Distance, plate centre can be set individually for each section and thus the fixing height. If the distance should be
the same for all areas, activate the All same checkbox.

Post connection, lateral - new connections for posts and base plates

Regarding the lateral post connection there are two new possibilities available for connecting posts and base
plates:

n Post, mitre cut

Instead of a distance plate, the same beam as for the post will be generated and a mitre cut will be applied to the
newly created beam and the post beam.

n Distance element

A distance element for the post beam and - if desired - an end cap will be installed. The excess length of the post
can be determined. If the distance element should be trimmed to the post, the respective checkbox has to be activ-
ated and the width of the obtuse end has to be entered.

Left: with distance element (trimmed) and end cap, right: post mitre cut
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Vertical infill

There are now more options for vertical rods:

n Vertical rods can now be rotated during the installation.

n Depending on the type of the chosen variant the connections will be with the beam, with the handrail, the post
or the boom. For example: the vertical rods can be inserted in the handrails or can be trimmed at the handrails,
with or without contour.

(1) Inserted in the handrails with gap, (2) without trim, (3) trim with contour

n Corner infills can now be aligned with the angle bisector of the corner.

Example of a corner infill: (1) corner rod, bisecting alignment, (2) corner rod, no bisecting alignment
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Steel Engineering BOM (Excel)

Differentiating between unprocessed and processed sheet metal

Sheet metal is now distinguished between sheets with identical cross-sections (unprocessed) and processed
sheets. Unprocessed sheets with identical cross-sections are characterised by at least one bend zone, parallel
front edges of the flanges (width of flange) and no further processing, e.g. subtractions, bores etc. For these sheets
a drawing is not necessary, only a BOM. All other sheets count as unalike and processed.

In order to differentiate between unprocessed and processed sheets in the BOM

1. the Special treatment for sheets with identical cross-sections checkbox has to be activated in the Con-
figuration Editor under Sheet Metal (by default deactivated).

2. the new template HiCAD_Stahlbau.2201.0 has to be used when creating a BOM.

In this case an additional spreadsheets for unprocessed sheets will be added in the Excel BOM:

Please note:

n For sheet metal and unprocessed sheets you can optionally view images of the sectional view (with dimensions)
in the BOM. To do so, go to the spreadsheet Settings in the HiCAD_Stahlbau.2201.0.xslx template, then to
the Create column and change the value for Sheet Metal parts with image to true . The ISD default setting is
false.

n For unprocessed sheets with identical cross-sections only one image will be created.

The display with images is on the spreadsheets

n Sheet Metal parts with images or

n unprocessed Sheet Metal parts with images
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Expanded short shipping list

For larger model drawings you often needmore than the first level of the part structure in the short shipping list. This
can now be modified by using the filter attribute %Stufe in the setting file for Excel BOMs (e.g. HiCAD_Stahl-
bau.2201.0.xlsx). You can for example set the filter criteria to 1,2 and set the exclusion filter to false, which means
that the shipping list contains level 1 and 2 of the part structure.

Others

Parameter Configuration

If the Steel / Metal Engineering option is selected in the Parameter Configuration, the BOM configuration HiCAD_
Stahlbau.rms will be set as the default configuration.

NCX export of unconnected multi-part beams

It is now possible to treat itemized, unconnected multi-part beams as one part for NCX exports when generating the
NCW files.
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Major Release 2017 (V 2200)

User interface

"Settings" menu changed

The functions:

Edit templates for part annotation

Templates, Attribute assignment

Article master, Itemisation

Document master, Detail drawing

Edit dimensioning rules

Dimensioning Settings

can now be found at Drawing > Itemisation/Detailing > Attr.. and Drawing > Itemisation/Detailing > Dim., respect-
ively.

Functions for detail drawings moved

The functions for detail drawing derivation for marked Steel Engineering parts can now be found at Drawing >
Itemisation/Detailing > Derive > Detail drawing - ....

Settings / Options

Settings for dimensioning

As of HiCAD 2016 SP2 it is possible to adjust

1. whether chain dimensions, which describe the fitting situation of parts, have separated chains for each type of
usage or not,

2. whether both contact points or only the first contact point of the chain should be measured for attached plates
as well as plates and beams which border on relevant beams

via the STW_DIMSETTINGS.XML file
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To do so the following adjustments have to be made in these rows:

Possible values Default

1. </PARAM><PARAM Name="SEPERATEDSUBPARTPOSITION" Typ-
p="INT" Value="1">

1 = separate

0 = do not separate

1

2. </PARAM><PARAM Name="SUBPARTPOSITION" Typ="INT" Value-
e="1">

1 = only the starting
point

3= starting and end
point

1

As of HiCAD 2017 these settings can also be changed via the Dimensioning Settings function.

Changed default setting for visualisation

If you start the Computer Parameter Configurator (HiCAD\exe\ParKonfigComp.exe) tool and choose the
Steel/Metal Engineering option there, the parameter Vertical axis during dynamic rotation about 3-D point in the
Configuration Editor at System settings > Visualisation will be preset to Greatest rise, spatial. This setting affects

the vertical rotation axis during multiple rotations using the Rotate view dynamically about 3-D point function.

Multiple rotating means that you

n rotate the active view into the required position,

n take over the current view with the cursor by a mouse click, and then

n call the Rotate view dynamically about 3-D point function again

The Greatest rise, spatial setting changes the rotation axis, i.e. the axis that has the greatest rise in the current
view will always be used. This allows a free rotation of the axis.
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Mounting drawings

Placing of annotations

The annotations of beams and sheets in workshop drawings can be made with or without leader lines. This can be
adjusted under Automatic drawing derivation > Mounting drawing > Annotations > Placing of annotations. The
checkboxes are activated by default. This means that the annotations are placed direction on the sheet or beam. If
there is not enough space to do so, the annotations will be done with leader lines.

If the checkboxes are deactivated, the annotations are categorically produced with leader lines.
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Automatic creation of axonometric view

Besides the projection types Front, Back Bottom, Left, Right, Top, Bottom you have now the additional option to
automatically create the axonometric view when generating mounting drawings. The selection window has been
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expanded accordingly for this purpose.

Production drawings

Modified default settings in the Configuration Editor

In the Configuration Editor the settings for Production drawing have been modified - depending on the parameter
configuration.

Path Parameter old new *1 new *2

Production drawing Leave external draw-
ing open

Close
drawing

Close
drawing

Leave drawing
open, switch to ori-
ginal drawing

Production drawing > Drawing Centre individual
view group

Production drawing > Drawing >
Drawing frames

Frame height
/ Frame width

0 / 0 410 /
584

410 / 584

Production drawing > Annotations
> Grid annotations

Grid annotation:
Line type of axis

1 5 5

Grid sub-system
annotation: Line
type of axis

1 5 5

Production drawing > Annotations
> Grid annotations > Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Annotations
> Grid annotations > Sub-system,
Font

Font HiCAD
01:
ANSI_
KON

Arial Arial

Production drawing > Devel-
opment

Dimension bend
lines

*1 Default template: Steel Engineering / Metal Engineering / Management + BIM

*2 Default template: Mechanical / Plant Engineering as well as user-defined template: ISD Default
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Development of Sheet Metal parts

In the Views for sheets dialogue window you can now specify the position of the sheet development view within the
view group. at the top, the bottom, on the right or left within the view group.

When working with usage-dependent configuration templates, the arrangement chosen in the corresponding tem-
plate will be preset. This presetting can be changed in the Configuration Editor at Automatic drawing derivation >
Production drawing > Usage-dependent > name > View group, with name being the name of the relevant tem-
plate. There you can choose the desired arrangement via the parameter Sheet development: Position in view
group.
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Hide boltings

You have now the option to specify in the HiCAD dialogue whether boltings are to be displayed in the production
drawing or not. The Settings for views dialogue window has been expanded accordingly for this purpose.

Beneath Visualisation you can specify whether boltings are to be shown in the views of the production drawing or
not.

The following settings are possible:

l Hide none
No bolts will be hidden. This setting corresponds to the behaviour before HiCAD 2016 SP1.

l Hide all
All bolts will be hidden.

l Hide only "Site bolts"
Only bolts with the property "Site assembly" or "Site production" will be hidden.

You can preset the visualisation for each usage in the Configuration Editor, at Automatic drawing derivation >
Production drawing > Usage-dependent > .... > Views. If the drawing parameters are loaded from a con-
figuration that has been saved in the Configuration Editor, the corresponding settings from the Configuration
Editor will be will be preset in the dialogue window.

What's new? 169 / 294

News Overview



Please note that these settings do not apply for bolts within structure assemblies (e.g. in the case of boltings
that have been inserted as "loose parts"). These bolts will not be displayed in the workshop drawing.
When you update a production drawing, the settings that were active during creation of the drawing will be
used..

Specify position of BOM

The dialogue window for view groups has been expanded. You can now specify whether a BOM is to be placed into
the view group of an assembly and if so, the position of that BOM.

The following settings are possible:

n Do not insert
No BOM will be inserted.

n Always within view group
A BOM will be inserted within the view group. The position of the BOM is specified via the setting in the Position
in view group listbox.

n Within drawing frame if only 1 view group
If only one view group is created, the BOM can also be placed in the drawing frame.

Position and layout of the BOM can be defined separately for each usage in the Configuration Editor at Automatic
drawing derivation > Production drawing > Usage-dependent > .... > View group. If the drawing parameters are
loaded from a configuration that has been saved in the Configuration Editor, the corresponding settings from the
Configuration Editor will be will be preset in the dialogue window.
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To change the position of the BOM in the view group subsequently, open the Drawing tab and choose Itemisa-
tion/Detailing > Derive > Change settings - Active view group, provided that a BOM had been created in this
view group.

Automatic sectional view creation for attached parts

If the Sectional views checkbox has been activated for in the Views for assemblies dialogue window, you can spe-
cify in the settings for view groups whether sectional views are also to be created for attached parts. This is possible
for:.

n Steel Engineering plates running transversely or diagonally to the main part axis,

n Steel Engineering plates running longitudinally to the main part axis and

n Beams running perpendicular to the main part axis.

According to the ISD default setting, sectional views are automatically created for Steel Engineering plates running
transversely or diagonally to the main part axis. When working with configuration templates, you can specify for
each usage which sectional views are to be created for attached parts. The setting can be defined in the Con-
figuration Editor at Automatic drawing derivation > Production drawing > Usage-dependent > name > View
group, with name being the name of the relevant template.

Connections / Design Variants

New Design Variants for stiffeners

Stiffeners can now be inserted via the new Design Variant Stiffener (2401) in the Civil Engineering functions dock-
ing window - with chamfered or filleted corners (internal or external), one-sided or double-sided, as partial stiffeners
or full stiffeners, with or without weld seams. In this way it is possible to change the stiffeners via the feature log
entries.
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Stiffener dialogue window
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Assigning of boltings

In various connections the elements of a bolting are combined into an assembly called Bolting. If you do not want
these assemblies to be part of the welded assemblies, i.e. if the Loose part option has been activated in the set-
tings, the Bolting assembly will not be assigned to the Loose parts assembly.

For the particular cases, this means:

n Front plate connection to web/flange (2320)

The front plate and the weld seams will be assigned to the assembly of the beam to be connected (1st beam).
Filler plates will be combined separately into a structure assembly (on the same level as the assembly of the 1st
beam) called Loose parts. The bolting will be inserted as an assembly called Bolting. The assignment of this
bolting and the reinforcement plates depends on the settings on the Boltings tab. There you can specify, next
to Assignment, whether this bolting group and the reinforcement plates are to be assigned to the assembly of
the 1st beam, or inserted as "loose parts". If the Loose part option has been activated, the Bolting assembly will
be inserted as an independent assembly on the same level as the assembly of the 1st beam. The reinforcement
plates will be combined into a structure assembly called Loose parts that also contains filler plates. This struc-
ture assembly is located on the same level as the assembly of the 1st beam.

n Front plate connection to web, double-sided (2322)

The front plate and the weld seams will be assigned to the corresponding assembly of the 1st beam and 2nd
beam, respectively. Filler plates will be combined separately into a structure assembly (on the same level as the
assemblies of the 1st and the 2nd beam) called Loose parts. The bolting will be inserted as an assembly called
Bolting. The assignment of this bolting depends on the settings on the Boltings tab. There you can specify, next
to Assignment, to which assembly the boltings and the reinforcement plates are to be assigned. If the
Assembly 1st beam/ Assembly 2nd beam option has been activated, the Bolting assemblies will be assigned
to the assembly of the 1st beam or the 2nd beam, respectively. If the Loose part option has been activated, the
Bolting assemblies will be inserted as independent assemblies on the same level as the assemblies of the
1st/2nd beam.

n Front plate connection to flange (2330)

The front plate and the weld seams will be assigned to the assembly of the beam to be connected (1st beam).
Filler plates will be combined separately into a structure assembly (on the same level as the assembly of the 1st
beam) called Loose parts. The bolting will be inserted as an assembly called Bolting. The stiffeners and the cor-
responding weld seams will be assigned to the assembly of the 2nd beam. The bolting will be inserted as an
assembly called Bolting. The assignment of this bolting and the reinforcement plates depends on the settings
on the Boltings tab. There you can specify, next to Assignment, to which assembly the boltings and the rein-
forcement plates are to be assigned. If the Assembly 1st beam has been activated, the boltings and the rein-
forcement plates will be assigned to the assembly of the 1st beam. If the Loose part option has been activated,
the Bolting assembly will be inserted as an independent assembly on the same level as the assembly of the 1st
beam. The reinforcement plates will be combined into a structure assembly called Loose parts. this structure
assembly is located on the same level as the assembly of the 1st beam. If filler plates have been inserted as
well, filler plates and reinforcement plates will be located in this assembly.

n Angle connection, one-sided (1305) / double-sided (1306)

For Angle connection 1305 up to 3 bolting groups called Bolting are created. The assignment of these bolting
groups and the reinforcement plates depends on the settings on the Boltings tab. If you have selected the pro-
duction type Workshop for one of the beams there, you can specify next to Assignment whether the boltings
are to be assigned to the assembly of this beam or combined into a structure assembly (on the same level as
the assembly of the beam) calledMounting screws. The L-brackets of the connection will be assigned to the
assembly of the beam with the production type Workshop. If you have chosen the production type Site, the L-
brackets and the and the boltings will be combined into a structure assembly called Loose parts.
For Angle connection 1306 up to 6 bolting groups called Bolting are created. The assignment of these boltings
and the L-brackets depends on the settings on the Bolting tab.
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n Purlin joint, 2 plates with mitre cut acc. to DAST IH (2201)

The front plate and the weld seams will be assigned to the assembly of the corresponding beam. Filler plates
are not assigned to this assembly, but are combined into a separate structure assembly called Loose parts. The
assignment of the boltings depends on the settings on the Boltings tab. There you can specify, next to Assign-
ment, to which assembly the boltings are to be assigned: If the Loose part option has been activated, the bolt-
ings will be combined into a separate assembly called Bolting. Otherwise, the Bolting assembly will be
assigned to the assembly of the first or the second beam.

n End plate (2102)

The end plates and the weld seams will be assigned to the assembly of the beam. Filler plates are not assigned
to this assembly, but are combined into a separate structure assembly called Loose parts. The base will be
entered into the part structure as a separate part called Base. The assignment of the boltings depends on the
settings on the Boltings tab. There you can specify, next to Assignment, to which assembly the boltings are to
be assigned: If the Loose part option has been activated, the boltings will be combined into a separate
assembly called Bolting. If you have chosen the Assembly option, the Bolting assembly will be assigned to the
assembly of the selected beam.

n Beam to web, with 2 plates and stiffener (1211)

The front plate and the weld seams of the first connecting plate will be assigned to the assembly of the first
beam to be connected. The second plate and the stiffener including the weld seams for the second plate will be
assigned to the assembly of the beam to which the connection is to be made. The bolting will be inserted as an
assembly called Bolting. The assignment of the boltings depends on the settings on the Boltings tab. There you
can specify, next to Assignment, whether this bolting will be assigned to the assembly of the 1st beam or as a
"loose part". If you choose the "Loose part" option, the Bolting will be inserted as an independent assembly on
the same level as the assembly of the 1st beam.

Repeated deletion of connections

Connections can now also be deleted "repeatedly", i.e. after deletion of one Design Variant-based connection, the

Delete function remains active. If you then select another edge belonging to a connection, further con-
nections can be deleted immediately.

To end the function, press the middle mouse button or the ESC key.
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Revised Base plate + Anchor plate connection

The new, revised Design Variant Base plate + Anchor plate (2101) replaces the old variant 1101.

You use this variant to insert base plates and anchor plates for columns (vertical beams). Insertion can take place
with welded plates and anchor plates, complete with shear connectors and head studs or anchors with inserts. The
insertion of ribs as additional stiffening elements on flanges and webs, or the applying of galvanization holes are
also possible.

(1) Base plate, (2) Filler plates, (3) Welded plate, (4) Anchor plate, (5) Ribs, (6) Bolting, (7) Insert, (8) Shear connector, (9)
Head studs, (10) Galvanization holes
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Base plate + Anchor plate (2101) dialogue
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Cross-bracing - Slotted plate with clearance

When inserting a Cross-bracing (1602) you have now the option to define a clearance for the slotted plate (strap on
gusset plate for the fixing of the round steel bars):
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Staircase / Railing Configurator

Railing with framework

If you select the infill variant Vertical rods with frame in the Railing Configurator, you have now the option to omit
the rods; to do this, deactivate the Rods checkbox on the Infill tab. As a result, railings consisting only of a frame
will be created.

Inputs for vertical rods with frame

(1) Rods + Frame, (2) Only frame
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New Design Variant for glass railings

The Infill, glass element variant has been revised completely. Allowed glass elements (material and glass structure)
are the glass panes from the catalogue Factory standards > Glass panes, the glass holders can be taken from the
catalogue Factory standards > Purchased/Factory standard parts.

Insertion can take place with or without glass holder, with or without bores in the glass elements and with selection
of processings on the beam. Furthermore, you can specify whether the glass holders are to be pre-mounted or not.

Inputs for glass elements
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For corners and transitions you can use individual infills if desired. Please note however that this is only possible if
no corner posts or transition posts have been used.

Example of a glass railing with individual corner infill
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Corner and transition infill for railings

For corners or transitions, the same infills as specified in the Infill tab will be used by default. If you want to use indi-
vidual infills here, activate the corresponding checkbox. Please note however that this will only be possible if no
corner posts or transitions posts are used.

Updating of staircases and railings

n Stairs and railings with deleted parts can no longer be updated! However, this concerns only new stairs and rail-
ings created with HiCAD 2017 (Version 2200) or higher.

n Stairs and railings created with older HiCAD versions (as of Version 2101.0) can be updated or changed if you
have subsequently deleted parts that have been created by the relevant variant. However, these parts will be re-
generated by the variant again upon updating if they are required due to the parameters and geometrical situ-
ation.
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NCX: Output series beams as one part
If you have activated the NCX export option Output itemized series beams as one part at the bottom of the dia-
logue window, series beams that have been subordinated to the assembly will not be exported as individual parts,
but as one part, provided that an item number has been assigned.
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Steel Engineering - Management + BIM

Service Pack 2 2017 (V 2202)

Mounting/customer drawings - Change detail

Use the new Detail function in the Mounting/customer drawing function group to subsequently change
details of mounting and customer drawings that were created with the Management + BIMmodule.

When you call the function, a dialogue window with a list of the mounting and customer drawings belonging to the
model drawing will be displayed.

To change a detail of a mounting/customer drawing, first choose the desired drawing in the displayed list (1). Then,
specify the new detail using one of the functions available in the drop-down list at the top right of the dialogue win-
dow (2).

After closing the dialogue window with OK the changes will be applied. To update the corresponding mounting and
customer drawings, the model must be itemized and saved beforehand. If you have changed only customer draw-
ings, saving of the model drawing will suffice.
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Then, choose Automatically update... and select the desired mounting/customer drawings in the displayed
list.

Mounting drawings - Rearrange views upon update
As for production drawings, you can now also switch off the automatic rearranging of views upon update in mount-
ing drawings created with the Management + BIM module. makes sense if, for instance, you have deliberately
moved some views and want to keep their new position.

This setting can be specified in the Configuration Editor at PDM > Management+BIM > Production drawings >
Rearrange views when updating mounting drawings.

The default setting is Rearrange.

Customer drawings - Itemisation no longer mandatory
In previous versions, an itemisation and saving of customer drawings was mandatory (as with workshop andmount-
ing drawings). After this, the itemized source model was also defined, preventing a working with individual con-
struction sections (Concurrent Engineering).

Now, an itemisation of the model is no longer required for the creation of customer drawings.

Locked customer drawings with old parts
If released customer drawings with old parts exist for the current model drawing, the following message will be dis-

played when you call the Automatically update... function:

This will, for instance, be the case if, after a release of customer drawings, changes are applied to parts in the
3-D model that belong to one of these customer drawings.
After clicking OK, a list of the old parts will be displayed.

To be able to update these customer drawings, you first need to call the Revision index function and
choose the corresponding customer drawing to remove the Release again. Then, choose the Drawing
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function to update the customer drawing. The status of the drawing will then be reset to In progress. With
the functions in the Customer... pull-downmenu you can then request an approval and release the drawing
again.

Tip:

Use the Locked old drawings function to check whether locked customer drawings with old parts exist.

Clean up project - Delete unused external documents

The Clean-up project function has been enhanced.

n After successful clean-up the following message will be displayed:

n If unused external documents exist in the selected project, such as DXF, DSTV-NC, STEP or NCW files, these
will be removed during project clean-up. Unused files can be created, for instance, when you delete documents
of production drawings in the HELiOS Desktop, and the above files belonged to these production drawings.

Production drawings for unprocessed beams depending on machine processing
Drawing creation for unprocessed beams can now also be controlled depending on later machine processing. For
this purpose,

n the new HiCAD attribute Processing note $BHW and,

n in the Configuration Editor at PDM > Management + BIM > Production drawings, the new parameter Pro-
cessing notes for unprocessed beams

are available.

For instance, you can achieve via this attribute that a production drawing is created for unprocessed beams that
need to be laser-cut, despite the current Production for unprocessed beams setting. For this to happen, the cor-
responding processing notes must be entered into the Collection Box of the Processing notes for unprocessed
beams parameter, e.g.:
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The following additional adjustments are required:

1. In the system files H_BHW.TXT (in the HiCAD sys directory) the processing notes must be added, too:

It is important that the spelling of the texts must be identical with those in the Collection Box (please also atten-
tion to case-sensitivity!).

2. In the system files BRW_3DTeil_Profil.HDX and BRW_3DTeil_Profil_H.HDX (in the HiCAD sys directory) the
attribute $BHWmust be activated. If you have set the Parameter Configuration to Steel/Metal Engineering and
Management + BIM, the corresponding definition has already been provided in the files; only the # character at
the start of the entry needs to be deleted:

3. The attribute $BHWmust be made item-relevant. To do this, open the Management + BIM tab, choose Parts >

Item... > ... with options and, in the dialogue window, click the Configuration button. In the dis-
played window, activate the attribute $BHW:
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Targeted itemisation control
The HELiOS link Itemized enables you to find out in whichmodel the parts have been itemized.

You can use the document attribute ITEMISATIONMODEL to explicitly control in which model parts are to be item-
ized. For this purpose you use the Itemisation checkbox in the dialogue window.

By default, this checkbox is activated for the model and deactivated for the derived drawings.

In certain cases, however, deactivating the checkbox can be useful, for instance, if you want to subdivided com-
plex model drawings into assemblies and individual construction sections, and distribute them to several work-
stations ("concurrent engineering"). In such cases, the processing, itemisation and drawing derivation in the
Management + BIM module will not take place in the original model drawing, but in the detail drawings of the
assemblies. Of course, changes in the assemblies will be also be transferred to the original model drawing due to
referencing. To prevent itemisation in the original drawing, deactivate the Itemisation checkbox in the document
master of the original model drawing.
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To deactivate the checkbox properly, two clicks may be required - otherwise, the checkbox may only be
greyed out, but not deactivated.
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Service Pack 1 2017 (V 2201)

Customer drawings for approval

Besides the creation of mounting, workshop and production drawings you can use the Customer drawing
function to create various customer drawings for approval, e.g. builders' or architects' plans. The procedure is
largely similar to that for the creation of mounting drawings.
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In contrast to the mounting drawing, however, you have the option to choose a Drawing type here. You can specify
the drawing types that are to be offered for selection via the Plan types parameter. The ISD default setting is the
drawing type "Kundenzeichnung" (=Customer drawing).

Customer drawings created with the Management + BIM module have their ownWorkflows, i.e. separate functions
for a setting to the Checkup and Released status are available.

Customer drawing, Request Approval

Customer drawing, Reject Approval

Customer drawing, Release

Customer drawing, Revision index

Mounting drawings
HiCAD 2017 SP1 also supports the Workflow for Mounting drawings. These can now also be set to the Checkup
and Released status.

The corresponding functions can be found at Management + BIM > Drawings > MntDrw > ....

Mounting drawing, Request Approval

Mounting drawing, Reject Approval

Mounting drawing, Release

Mounting drawing, Revision index

Revised Ribbon tab
The Management + Ribbon tab has been expanded to include the new functions for mounting drawings and cus-
tomer drawings.
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Parameter configuration with new message
When you confirm a new setting in the HiCAD Parameter configuration dialogue window with OK, the following
message will now be displayed:

After confirming this message with OK, attributes, settings in the Configuration Editor, BOM templates, annotation
templates, drawiong frames and HELiOS masks will be automatcally configured for the Management + BIM mod-
ule.

In the process, various system files in the HiCAD sys and Szenen directory will be replaced with the files supplied in
the HiCAD templates directory (for Management + BIM these are the folders TEMPLATES\MODULE_
3DSTEEL\BIM\sys and TEMPLATES\MODULE_3DSTEEL\BIM\szenen). These contain, for instance:

n HELiOSmasks for projects, documents and articles (*.MSK),

n Various configuration files (*.HDB),

n Template files for annotations (*.FTD)

n Drawing frames with BIM-specific title blocks.

Therefore, you should always make backups of the files that you want to adjust, or contact your nearest ISDoffice
before making the adjustments.

Click Cancel to discard the changes to the configuration.

Workflow status in the ICN
Parts from released drawings and parts in "Checkup" status are marked accordingly in the ICN. In previous ver-
sions, these markings of the Workflow status had been automatically updated in case of changes.

To speed up the build-up of the ICN in case of a slower interface to HELiOS or very large drawings, the conditions
for these updates can be set in the Configuration Editor at PDM > Management + BIM > Workflow status in ICN.

Possible settings are:

Always The workflow status will always be directly updated for all parts.

Always (without standard
parts)

The workflow status will be updated for all parts except for standard parts.

Upon saving The workflow status will only be updated for all parts after saving.

Upon saving (without standard
parts)

The workflow status will only be updated for all parts except for standard
parts after saving.

The ISD default setting is Always.
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Generation of STEP files separately for beams, plates, sheets etc.
The generation of the part data in STEP format can now be performed separately for beams, plates, glass panes
and gratings. In previous versions, only a separate generation according to assemblies was possible.

For this purpose the setting options in the Configuration Editor at PDM > Management + BIM > External pro-
duction drawings > Collect part types for STEP export have been expanded accordingly.

Suppress unprocessed Sheet Metal parts in production drawings
One distinguishes between sheets with identical cross-sections (unprocessed sheets) and processed beams. If
desired, you can suppress the output of sheets with identical cross-sections in the workshop drawing.To do this,
choose Sheet Metal and activate the Suppress productions drawings for sheets with identical cross-sections...
checkbox. The checkbox is deactivated by default. Click here for further information.

If you change this setting in the Configuration Editor, already itemized sheets need to be re-itemized and saved!

CAM data for unprocessed sheets
One distinguishes between sheets with identical cross-sections (unprocessed sheets) and processed sheets.

n As "cross-sectionally identical" (unprocessed) are considered all sheets with at least one bend zone, parallel
front edges of the flanges (width of flange) and without any further processings such as bores, subtractions etc.

n All other sheets are considered non-identical and processed.

The CAM data for unprocessed sheets parameter in the Configuration Editor at PDM > Management + BIM >
External production drawings allows you to determine whether the "unprocessed" sheets are to be considered for
the creation of the CAM data or not.
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Major Release 2017 (V 2200)

Changed settings for referencing

If you have activated theManagement + BIM  checkbox in the HiCAD Parameter configuration dia-
logue window, the Lock parts for other users via HELiOS article master checkbox will be deactivated
in the Configuration Editor at System settings > Referencing.

New "Information" function group
The new Information function group has been added to the Management+BIM Ribbon tab.

Use the new functions to display BIM-relevant information for the active assembly and check the active drawing for
invalid parts.
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The following functions are available:

Information, All parts in active assembly

This function displays BIM-relevant information for the active part or assembly.

Information, BOM-relevant parts

Lists the BOM-relevant parts of the active assembly.

Information, Production-relevant parts

Lists the production-relevant parts of the active assembly.

Information, Non-project parts

Lists the parts that do not belong to the active project.

Correction, Invalid parts

This function searches in the active drawing for parts with invalid part masters. If such parts are
found, these will be listed here. When you close the list you will have the option to remove these art-
icle masters.

Correction, Invalid BOM-relevant parts

This function searches in the active drawing for parts with invalid BOM-relevent part masters, i.e. for
parts that must not be BOM-relevant.

Expanded setting options for output of external part and drawing data
n DXF part data can now also be generated exclusively for Steel Engineering plates. The selectionmenu in the

Configuration Editor at PDM > External production drawings > External part data > Create DXF data has
been expanded for this purpose.

n You have also the option to generate DWG, DXF and PDF data of a production drawing exclusively upon its
release. The selectionmenu in the Configuration Editor at PDM > External production drawings > External
part data > Create DWG files for production drawings > ... has been expanded accordingly.

194 / 294 What's new?

Steel Engineering - Management + BIM



FORMAT attribute
During generation of production drawings the HiCAD attribute Article number ($BB) of the drawing frame will be
transferred to the HELiOS document attribute FORMAT.
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Metal Engineering

Service Pack 2 2017 (V 2202)

Import of LogiKal glass panes with circular arc-shaped frames
You have now the option to import glass panes from LogiKal with circular arc-shaped frames:

To ensure an error-free import, please update LogiKal to the most recent version beforehand.

Changed licensing
The licensing requirements for the Metal Engineering module have changed:

Minimum requirements for the HiCAD Metal Engineering module now comprise HiCAD creator and HiCAD Beam-
s+Profiles. A prerequisite for the HiCAD Steel/Metal Engineering module is the existence of HiCAD creator.
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Automatic creation of View Coordinate Systems
When inserting a LogiKal facade in HiCAD, a View CS will now be set automatically.
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Service Pack 1 2017 (V. 2201)

Taking over of LogiKal item name into Part attributes mask
For beams, profiles and glass panes that have been imported from the LogiKal item database to HiCAD, the LogiKal
item name will be shown as a HiCAD part attribute in the in the Part attributes dialogue window.

You will find the corresponding attribute in the LogiKal item name field:

Create part via part catalogue

When you called the Create part via part type catalogue, as main part function via the context menu for
sketches in older versions, you were prompted to select the sketch again. T

This step will be omitted as of SP1, since the sketch has actually already been selected via the right-click.

Workshop drawing - No taking into account of connecting elements in Metal Engineering
If your model drawing contains connecting elements that have been created with the 3-D section functions, these
will not be considered in the workshop drawing - even if these elements are BOM-relevant.
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Major Release 2017 (V 2200)

Direct call of eluCad from HiCAD

Use the eluCad function to transfer parts directly to the eluCad software. The transfer takes place externally
via export of the parts to the NCX format. The restrictions of the NCX format apply here, too: An export of assem-
blies is not possible and only BOM-relevant parts will be exported. Other export settings will be the default values of
the NCX interface:

For further information on the NCX format please refer to the Online Help for Interfaces .The installation of eluCad
will be found automatically, no configuration will be required.
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Apply insertion direction for several foils

The dialogue for the specification of the insertion direction of foils now features the additional option Apply inser-
tion direction for the following edges. If you want to insert a foil along several edges, you can activate this function
to apply the insertion direction of the first edge to the following edges in one go instead of having to specify the dir-
ection for each of the edges one by one.
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Plant Engineering
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Service Pack 2 2017 (V 2202)

Part insertion

New connection types / asymmetric flange connections

HiCAD Plant Engineering now also supports asymmetric flange connections, i.e. connections of flanges with dif-
ferent shapes. For this purpose, the following new connection types are available:

n 21000 (Flange with groove) and

n 22000 (Flange with notch).

One example for an asymmetric flange connection is a connection of a flange with groove to a flange with notch
according to DIN 11853-2.

The Connection types dialogue window has been expanded accordingly. To open this dialogue window, choose
Plant Engineering > Settings > Settings. In the Plant Engineering Settings dialogue window, open the Part
search tab and click the Connection types button at the bottom right. The default setting looks as follows:

If connection type combinations of from older HiCAD versions (before HiCAD 2017 SP2) exist when you start
HiCAD, the following message will be displayed:

Changed function dialogues

To limit the number of matching counter-flanges for asymmetric flange connections, the following functions have
been revised:
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n Pipe parts (PE)
Concerns the part-dependent insertion type Connect when inserting a flange

n Pipe parts (PE)
Insertion option AutoFlange

n AutoPlace parts on guidelines (PE)
If the Insert connecting pieces option has been activated (Plant Engineering Settings, Fasteners tab), with
flanges as fasteners.

Fasteners for asymmetric flanges may have the Connection type 20000, so that they can be provided on both sides
of the flange connection during part insertion.

Parts for food ducts

HiCAD now also supports the construction of food ducts. For this purpose the standard part inventory has been
expanded accordingly. The archive file list foodline.lst in the HiCAD-directory PlantParts lists the new variants. To
be able to use the new parts, perform a part data synchronization with the database or the HiCAD catalogue,
respectively.

Example

Example with Isometry
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Food ducts Variant

DIN EN 10357-A (replaces DIN 11850 Series 2) EN10357-
A.vaa

DIN EN 10357-B (replaces DIN 11850 Series1) EN10357-
B.vaa

DIN EN 10357-C (corresponds to ISO dimensions) EN10357-
C.vaa

DIN EN 10357-D (corresponds to OD and SMS dimensions) EN10357-
D.vaa

DIN 11866-A (corresponds to DIN EN 10357 dimensions) N11866-A.vaa

DIN 11866-B (corresponds to DIN EN ISO 1127 dimensions) N11866-B.vaa

DIN 11866-C (corresponds to ASME-BPE 2009 dimensions) N11866-C.vaa

Standard parts acc. to DIN EN 10217-7 (replaces DIN 17457) also fall into the "Food ducts"
category

EN10217-7-
1.vaa

Duct fittings acc. to DIN 11852 Variant

Reducer, concentric N11852-RK.VAA

Reducer, excentric N11852-RE.VAA

Elbow 45° N11852-BS-45.VAA

Elbow 90° N11852-BS-90.VAA

Elbow 90°, long N11852-BL-90.VAA

Elbow 180° N11852-BS-180.VAA

T-piece, short N11852-TK.VAA

T-piece N11852-TS.VAA

Reduced T-piece, short N11852-TK-RED.VAA

Reduced T-piece N11852-TS-RED.VAA

T-bend N11852-TBEND.VAA

Y-bend N11852-YBEND.VAA

Cross, short N11852-XK.VAA

Cross N11852-XS.VAA

Releasable connections comprise pipe unions, flange connections and clamped connections. Due to the special
construction of these connections, they have been modelled according to connection types 21000 and 22000,
i.e. they are internally regarded as flange connections. For each of these connections, a "complete" version exists,
modelling this connection as one single part. The complete versions are "Other parts".

What's new? 205 / 294

News Overview



Pipe unions acc. to DIN
11853-1

Variant

Screwed pipe union,
complete (DIN 11853-1)

N11853-1_
RV.VAA

Pipe union - consisting of two sockets, one seal and one nut

Threaded socket, short
(DIN 11853-1)

N11853-1_
GS.VAA

Socket with notch, short
(DIN 11853-1)

N11853-1_
BS.VAA

Threaded dummy socket
(DIN 11853-1)

N11853-1_
GBS.VAA

Dummy socket with
notch (DIN 11853-1)

N11853-1_
BBS.VAA

Slotted nut (DIN 11851) N11851_
NUT.VAA

Sealing ring (DIN 11851) N11851_
OR.VAA

Please note:

n In the HiCAD standard parts inventory, the sockets have beenmodelled as "flanges". This allows an automatic
insertion of sealing rings as flange seals. For this to happen, the via DICHTUNG attribute optionmust have
been activated on the Part selection tab of the Plant Engineering Settings dialogue window.

n The slotted nut has beenmodelled as an asymmetric fastener andmade available accordingly in the con-
nection type attributes of the sockets. To ensure their automatic insertion, the options Insert fasteners and
Selection via connection type attribute must have been activated on the Fasteners tab of the Plant Engin-
eering Settings dialogue window.

Flange connections acc. to DIN
11853-2

Variant

Flange connection, complete (DIN
11853-2)

N11853-2_
FV.VAA

Asymmetric flange connection

Flange with groove (DIN 11853-2) N11853- 2_
NF.VAA

Flange with notch (DIN 11853-2) N11852- 2_
BF.VAA

Blank flange with groove (DIN
11853-2)

N11853- 2_
BNF.VAA

Blank flange with notch (DIN
11853-2)

N11853- 2_
BBF.VAA

O-ring (DIN 11853) N11853_
OR.VAA

For an automatic insertion of the O-ring, activate (as you would do for the pipe unions), the via DICHTUNG
attribute option in the Plant Engineering Settings.
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Clamped connections
acc. to DIN 11853-3

Variant

Clamped connection, com-
plete

N11853-3_
KV.VAA

Clamped connection

Clamped socket with
groove

N11853-3_
NK.VAA

Clamped socket with
notch

N11853-3_
BK.VAA

Clamped dummy socket
with groove

N11853-3_
BNK.VAA

Clamped dummy socket
with notch

N11853-3_
BBK.VAA

O-ring N11853-3_
OR.VAA

Clamp N11853-3_
KL.VAA

The clamped connections, too, have beenmodelled according to the connection types 21000 and 22000, to
enable the automatic insertion of the O-ring as seal via DICHTUNG attribute . The clamp is an asymmetric
fastener.

The following valves with connection parameters according to DIN 11852 for butt-welded pipes on both con-
nections (SS) are now contained in the standard parts inventory:

Valves acc. to DIN 11852 Variant

Disc valve SS, hand-operated N11852_BUTTERFLYVALVE.VAA

Disc valve SS, pneumatic N11852_BUTTERFLYVALVE_PNEU.VAA

Ball valve SS, hand-operated N11852_BALLVALVE.VAA

Ball valve SS, pneumatic N11852_BALLVALVE_PNEU.VAA

heco orbital welding ball valve N11852_HECO_BALLVALVE.VAA

Pipe clamps acc. to DIN EN 10357 A Variant

Pipe clamp EN10357-A_RS.VAA

Pipe clamp with shank EN10357-A_RSS.VAA

Pipe clamp, foldable EN10357-A_RS_K.VAA

Pipe clamp with shank, foldable EN10357-A_RSS_K.VAA

Pipe holder EN10357-A_RT.VAA

Pipe support EN10357-A_RA.VAA
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Create and modify guidelines

Changed function dialogues

Normally, the Work with guideline mode must have been activated if you want to use the Guideline Tools func-
tions. In previous versions, a message was displayed if this was not the case.

You had to confirm with OK, change the Plant Engineering settings accordingly and call the function again.

As of HiCAD 2017 SP2 you have the option to activate the Work with guideline mode directly in the dialogue win-
dow.

If you click Yes, the Work with guideline mode will be activated in the Plant Engineering Settings and the function
will be continued immediately. This also applies to the functions Exchange parts and Change pipe class and/or nom-
inal diameter of all parts.

Easy drawing of parallel guidelines

The Guideline Editor allows the determining of axes onto which points specified with the help of the graphic cursor
can be projected. This method simplifies the construction of guidelines along defined directions. In older versions
these projections were only possible for free points, but not for points determined via snap options, or point options
such as I, J, M etc. This made a drawing of guidelines running parallel to existing structures rather difficult.

As of HiCAD 2017 SP2 the Guideline Editor offers the additional Always project points on axes checkbox. If you
activate this checkbox you can project any point that you want.

208 / 294 What's new?

Plant Engineering



An example on how this new option works can be found here.

New symbols during drawing of guidelines

During the drawing of guidelines the next selected point will be symbolized as a slightly smaller blue circle.
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Assign guideline remainder to another pipeline

The Assign guideline remainder to another pipeline function has been revised.

Proceed as follows:

1. Select the segment of the guideline that you want to assign to another pipeline. The position of the graphic
cursor determines which segment of the guideline will be selected. Please note that the selected segment must
not contain any parts!

2. Select the target pipeline. The selected guideline section will be assigned to this pipeline (if the pipeline to
which you want assign the guideline remainder does not exist yet, create it using the Create pipeline function).

Please note:

n The original pipeline can also be used as target pipeline. This will only divide the guideline, but not assign it oth-
erwise.

n You can also select the entire guideline as one section, provided that no parts have been placed on it yet. This
allows you to assign the entire guideline to a different pipeline.

Part Tools

Connect pipes

The Connect pipe function has been revised. The function connect pipes that can belong to different
pipelines andmay have different diameters.

In older versions the procedure was as follows:

1. Selection of the thicker pipe,

2. Selection ofconnecting point,
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3. Selection of the thinner pipe.

Then, HiCAD checked whether the connection actually made sense. For this to happen, the connecting point must
already have been located on the centre line of the thicker pipe. If this was the case, the pipe was connected, i.e.
an connecting point was applied to the thicker pipe and the thinner pipe was trimmed accordingly.

As of HiCAD 2017 SP2 the order of the pipe selection does no longer matter. Also, the connecting point of the thin-
ner pipe does no longer need to be already located on the centre line of the thicker pipe. If required (and possible),
the connection point of the thinner pipe will now be moved towards the connection by means of a route change.

An example:

In this example the straight pipe (1) is to be connected to the seamless steel tube (2).

Select the straight pipe (1) and the elbow (2).
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HiCAD detects the possible connecting points - here, two of them - and prompts you to choose the desired point.
Select the lower point. The function will be executed.

If you had chosen the upper connecting point instead, the connection could not have been created. In this case,
HiCAD would have displayed the following message:
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Service Pack 1 2017 (V 2201)

Part Insertion / Create Pipelines

Highlighting connection points during part insertion

If the reference point during part insertion is chosen freely with the Connection from graphic option, a full-screen
preview of the part will be displayed. In addition to that, the connection points will be highlighted and the point
names will be shown.
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Adopt pipeline name from P+ID

When creating a pipeline and assigning a pipe class from the P+ID, the pipeline name will also be adopted from
P+ID.
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Part Tools

Divide pipe

With the new Divide pipe function it is possible to divide a single pipe into two separate pipes.

Select a point on a dividable pipe. This can be a straight pipe or a straight section of a bent pipe.

The point selection is restricted to a grid depending on the pipe length, similar to the one you can find during part
installation. If you move the cursor over the pipe, the active point will be visualised graphically. By clicking the left
mouse button, the pipe will be divided into two at this point.

If you prefer selecting the point via the point options, you can do so by activating the context menu. In this case the
cursor should always be over the part which you want to divide. The part which will be divided at the selected point
will be additionally highlighted in the point optionmode.
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Pipeline Tools

Close gaps within a pipeline

When replacing parts or also after automatically placing parts on guidelines, gaps might occur in the pipeline route.
At the latest when an isometry drawing should be created the pipeline route has to be connected. There are other
functions which depend on a continuous pipeline route, e.g. the Divide pipeline function.

The Close gaps functionmarks gaps in the chosen pipeline route and offers you to close them.

In the displayed pipeline there is for example a small gap between the elbows. It is highlighted with arrows.

If you move the cursor over the arrows a text will appear which suggests that gaps can be closed by clicking on
them. The results of closing gaps can vary, depending on the arrows you choose. Only the side of the selected
arrow will be modified.
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Use pipeline colour as edge colour

Via the Change pipeline colour the pipeline colour will now not only be used as surface colour but as edge col-
our as well. This means that all parts of the chosen pipeline will receive the pipeline colour for surface and edge col-
our.

This can also be edited in the Plant Engineering settings, by activating the Set edge colour to pipeline colour
checkbox in the Part insertion tab.
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Guideline Tools

Deleting edges of a guideline

If the guideline is broken up into several sections by deleting edges, the guideline will now be divided into separate
parts.

For example, if edges (1) and (2) are deleted in the displayed guideline, three separate guideline parts will emerge.

Merge guidelines

When creating and editing guidelines it may be that a pipeline contains two guideline parts with overlapping end
points.

Via the Merge guidelines function these constellations can be found andmerged. This functionmerges all pos-
sible guidelines of a pipeline.
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Isometry and Pipe Spool Drawing

Switching off identical part search when assigning PE item numbers

With the Plant Engineering itemisation you can have a distinct item number assigned to each part. To do so the
Item numbers tab has been expanded by a checkbox.

If this checkbox is activated, parts of a kind will not be combined in one item. As an example, this could be used in
order to itemise parts of a pipeline along the flow direction.

New format for connection item numbers

Itemising the connections of a pipeline now includes item numbers, which use the part's item number as prefix and
only count up the item of the connection in second place. For that reason, the Connections tab of the Isometry and
pipe spool drawing settings has been expanded by a checkbox.

Please note that the setting have to be modified for each connection type. You can e.g. itemise welded con-
nections in this way and socket-welded connections in the previous way.

The part which provides the prefix is always the one directly before the connection in flow direction.
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An example with displayed flow direction and parts itemised along the flow direction (identical part search: off):

Automatic dimensioning settings

On the Automatic dimensioning tabs of the Isometry and Pipe Spool Drawing settings dialogue windows the "Rel-
ative" option beneath Draw angular dimensions is no longer available.
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Major Release 2017 (V 2200)

New variants

SWAGELOK - Metering valves, Plug valves, Pipes

New SWAGELOK parts are now available. The following feature variants (.VAA) have been created:

SWAGELOKMetering valves SWAGELOK Plug valves SWAGELOK Pipes

SWAGELOK_MVALVE

SWAGELOK_MVALVE_31

SWAGELOK_MVALVE_31_METRIC

SWAGELOK_MVALVE_3W

SWAGELOK_MVALVE_90

SWAGELOK_MVALVE_90_31

SWAGELOK_MVALVE_90_31_METRIC

SWAGELOK_MVALVE_90_FNPT

SWAGELOK_MVALVE_90_METRIC

SWAGELOK_MVALVE_90_MNPT

SWAGELOK_MVALVE_90_MNPT_INCH

SWAGELOK_MVALVE_FNPT

SWAGELOK_MVALVE_METRIC

SWAGELOK_MVALVE_MNPT

SWAGELOK_PVALVE

SWAGELOK_PVALVE_FNPT

SWAGELOK_PVALVE_ISO_FEMALE

SWAGELOK_PVALVE_METRIC

SWAGELOK_PVALVE_MNPT

SWAGELOK_PVALVE_MNPT_FNPT

SWAGELOK_PVALVE_MNPT_INCH

SWAGELOK_PIPE

SWAGELOK_PIPE_METRIC

When you perform an update, these parts must be entered, via the DBPlantDataImport or PartDataAutoSync tools,
into the database or the HiCAD catalogue, respectively. The corresponding archive file lists are as follows:

n Metering valves: Swagelok_Metering_Valves.lst

n Plug valves: Swagelok_Plug_Valves.lst

n Pipes: Swagelok_Pipes.lst
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Ermeto valves

The following new variants (.VAA) for Ermeto valves are available:

Ermeto Ball valves Ermeto Valves

EO_KH_3W_L

EO_KH_3W_S

EO_KH_L

EO_KH_S

EO_DV_L

EO_LD_S

EO_VDHA_S

EO_WV_L

The Ermeto variants have been grouped according to series in the following three archive list files:

n EO_LL.lst

n EO_L.lst

n EO_S.lst

The new valves have been added to the matching .lst file.

New database entries

New attributes

If you are using the PDM system HELiOS as part data source you have the option to use the route of the guideline
as a restriction for part selection. The following attributes which will be analysed during the part insertion are avail-
able for this purpose:

n PLANE_RESTRICTION and

n BENDING_RESTRICTION

When you start the DbPlantDataImport.exe tool for the configuration of your database and click the Update
HELiOS for Plant Engineering button, both attributes will be added to the database.
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Expanded search masks

n The new ANSCHLUSSART2 (CONNECTION_TYPE2) field has been added in the searchmask for valves. This
allows the support of parts like the "Swagelok Plug valve P4T/P6T NPTmale thread on tube fitting in inches"
with a screwed connector at one end, and a plugged connector at the other end.

Search masks for valves

224 / 294 What's new?

Plant Engineering



n The new DRUCK (PRESSURE) field has been added to the searchmask for fasteners. This allows the support of
parts like the glass fiber reinforced polyester resin pipe fittings, for which the pressure is a relevant factor.

Search mask for fasteners
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HELiOS as Part Data Source

Use the Guideline Route for the Restriction of Part Selection

If you are using the PDM system HELiOS as part data source you have the option to use the route of the guideline
as a restriction for part selection. The following attributes which will be analysed during the part insertion are avail-
able for this purpose:

Attribute name Designation

PLANE_RESTRICTION Bend plane

BENDING_RESTRICTION Bending direction

If the route of the guideline does not match the attribute value of the part that is to be installed the part will be
ignored.

These attribute are useful if you want to restrict the part selection options for more extensive pipe classes when
inserting the parts, so that only one, unique selection is possible and no searchmask will appear.

PLANE_RESTRICTION

This attribute encompasses the following values:

0 no restriction

1 Only make part available for selection if the guideline's bend or branch runs horizontally - based on the
world coordinate system - to the fitting position.

2 Only make part available for selection if the guideline's bend or branch runs vertically - based on the
world coordinate system - to the fitting position.

This attribute is currently being analysed for T-pieces.

BENDING_RESTRICTION

This attribute encompasses the following values:

0 no restriction

1 Only make part available for selection if the guideline's bend - based on the world coordinate system -
curves upwards.

2 Only make part available for selection if the guideline's bend - based on the world coordinate system -
curves downwards.

This attribute is currently being analysed for the part type knee.

These attributes are not in use in any of the part variants supplied by the ISD, thus the supplied HELiOS
masks do not contain them either. Both attributes are useful for reducing the part selection when installing
parts in extensive pipe classes so that the selection becomes definite and no searchmask appears.

If you are using the DbPlantDataImport.exe tool for the configuration of your database, select the Update
HELiOS for Plant Engineering button and both attributes will be added to the database.
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Pipeline Tools

Change route

A new function is available via Plant Engineering > Pipeline Tools > Change:

Change route.

With this function it is possible to change the route of an already installed pipeline. It only takes into account those
segments of the pipeline whose length can still be modified. In general this includes straight pipes, straight seg-
ments of bent pipes and guidelines. Guidelines and parts are treated equally. Parts will not be deleted and angles
will not be modified.

After clicking on the function HiCAD will prompt you to select the point that is to be shifted. When moving the
cursor over the drawing's pipeline all eligible points will be marked in the respective colour (Special Colour Marking
1). Select the desired point. In the drawing this point (Special Colour Marking 3) together with the respective
pipeline will be coloured. Left-click to adapt this point. HiCAD will ask you to specify the target point of the changed
route.

When HiCAD requests a target point the display of the pipeline changes. It is layered with a line representation
which shows the route of the pipeline. This line representation consists of grey and coloured segments. The grey
segments are unchanged in their width while the coloured segments can be stretched or compressed. You can
denote the coloured segments as unchangeable at any time via selecting the corresponding function from the con-
text menu.

Apart from the line representation two points will be coloured. The light point (Special Colour Marking 2) is the point
that you have selected to be moved. The dark point is the so-called fixed point. Fixed points are points whose pos-
ition in the room are is unchangeable. After selecting the point that will be moved HiCAD suggests a fixed point
automatically.

If you are content with the current cursor position press the middle mouse button. The changed route will be pro-
cessed.

(1) point that is to be moved, (2) target and fixed point, (3) result
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In order to determine the target point a context menu with further functions is available:

Pipeline Isometry / Pipe Spool Drawing

Less disk space required for drawings with implied connected elements

If the Indicate connected elements option is activated when generating a pipeline isometry those connected ele-
ments used to be taken over in the newly constructed drawing. These elements are often times very complex,
which leads to more disk space being required in an isometry drawing. A few examples are vessels with many
nozzles or measuring tools that are displayed in great detail.

These parts will be simplified from now on, which drastically reduces the size of an isometry drawing in many cases.
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Separately removing auxiliary lines for dimensioning

The Add/remove element function in isometries and pipe spool drawings now allows the separate removal of aux-
iliary lines for dimensioning - regardless of whether the Auxiliary lines for arcs checkbox is activated or not.

Associative dimensions and auxiliary lines for dimensioning in the pipe spool drawing

Dimensions in the pipe spool drawing now derive the dimension figure "from drawing", i.e. the figure determined in
the drawing will be used as dimension figure. This means that the dimensions and auxiliary lines for dimensioning
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are now associative. If there is no isolated point at a dimension base point an auxiliary point will be created and
assigned to an appropriate part.

Part insertion

Placing of parts on guidelines

During interactive part insertion, some parts require the specification of the insertion position on the guideline with
the cursor. In older versions, the cursor could only be moved along the guideline.

In HiCAD 2017 the placing of parts on guidelines has been made more flexible: The cursor can now be moved
freely, also allowing the selection of points outside the guideline for the specification of the insertion position. In
these cases the insertion position is the projection of the selected point onto the guideline. This methodmakes part
alignment much easier in many cases.

In the image below, a pipe clamp (4) is to be mounted on the Part (1). After selecting the pipe, it will be hidden (2)
and the insertion position can now be freely selected (3).
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Flanges

Pipe-dependent placing of loose flanges

Loose flanges can be placed manually or automatically on the connecting point of straight pipes. In the process,
the first connecting point of the loose flange will be placed on the connecting point of the straight pipe. Sometimes,
however, it is desirable to move the representation of the loose flange slightly away from the connecting point, e.g.
in cases where the straight pipe ends with a flanged edge which is not to be overlapped by the geometry of the
loose flange.

To achieve this, you can define a suitable distance in the feature variables of the straight pipe. This distance must
be stored in the Variable F1 for the first connecting point, and in the Variable F2 for the second connecting point.

Even if the end of the pipe is a flanged end, the required connection type will be 10000 (welded connection).

The result will look as follows:

(1) Straight pipe, (2) Loose flange, (3) Collar piece, modelled as straight pipe defining a distance of the loose flange
via F1 for the first connecting point.

After insertion of the loose flange, its first connecting point will still be located at the end of the straight pipe, but the
part geometry and the second connecting point have beenmoved away from the connection by the value F1.

During manual placing of loose flanges, please bear in mind that the Guideline mode must be switched off,
and that Connection 1 on target connection must have been selected during insertion.
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Other enhancements

Performance

Performance could be increased in the following areas:

n In older versions an UNDO backup for the entire pipeline was made, which is now limited to the guideline only.
This increases the speed of the function significantly.

n After executing the Move points function (for the correction of pipe routes by the moving of points)
HiCAD performs various "clean up" actions. The time required for these actions could be reduced to about a sev-
enth of the time that was previously required.

n The Delete part function is used for the repeated deletion of parts from pipelines. In previous versions an
UNDO step for the entire pipeline was created after each part selection. From HiCAD 2017 onwards the UNDO
step will be limited to the affected parts. As a result, the time for the deletion of Plant Engineering parts could
be reduced significantly (up to 50% according to various tests).
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P+ID

Service Pack 2 2017 (V 2202)

Sheet master data modified
It is possible now to enter empty entries for the sheets in the Combo boxes of the freely configurable attributes for
the title block dialogue via the functions New sheet or Edit master data.

In addition, you can switch on and off the assignments and edits of the freely configurable attributes by clicking on
the checkbox above the block.
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Product structure

Store part data in P + ID library

It is now possible to assign part data to symbols of P+ID libraries. For this purpose, the buttons Part data and
Delete part assignment have been added to the symbol mask.
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If there is no data base part ID stored yet, select the button Part data to open the article search mask. In case of a
pre-selection of the article searchmask a potentially given Part type ID within a symbol mask will be considered.
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However, if a database part ID is available, the part data will be displayed and can be deleted via the button Delete
part assignment.
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Set dummy article automatically

The P + ID supports dummy articles. Basically, dummy articles are articles without assigned attributes but which
are assigned to the part type (COMPONENT TYPE) R+I-dummy article. Such articles are useful during adjustment
with the product structure from the P + ID, since they represent a place holder for actual articles. On that note, it is
for example possible to create intermediate BOMs without defining any concrete articles.

Dummy articles are created automatically by the program DbPlantDataImport.exefor each Plant Engineering clas-
sification in HELiOS.

The ISD Configuration Editor allows activating automatic assigning of dummy articles:
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If the automatic allocation is active, the fitting dummy article will be determined always when inserting a symbol
with a part type ID from a P + ID library to a P + ID scheme.

A link to the dummy article will be written onto the attribute Data base part ID if it is available and blank. An already
used data base part ID attribute will not be overwritten.

Product structure transfer from a P + ID

It is now possible to transfer a P + ID or parts of it to HELiOS in the form of a product structure. You can determine
which attributes are to be transferred to the product structure.

First, create a new 2-D assembly via the function Main assembly on the 2-D Part tab. In the 2D-Part struc-
ture, move the symbols beneath the assembly to ensure that the assigned articles (=part data) of the symbols will
belong to the product structure of the assembly.

Now, assign an article master to the assembly. This takes places via the context menu (right-click on the entry in
the 2D-Part structure, then choose HELiOS > Article Master new + assign or ...select + assign. Here, the text
Article for assembly will be entered in Designation 1:
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Now a transfer of the product structure to the article is possible , once again via the context menu (right-click on
the entry, then choose HELiOS and Transfer structure, one level ). If applicable, attributes Function (PID_
FUNCTION) and Code (PID_GERAET) need to be configured in the product structure . Click on the article with RMB
and choose Configure... . Then, click Add attributes and select from the appearing list Function (PID_
FUNCTION and Code (PID_GERAET). Leave the list by clicking OK and select Save as standard. Confirm here with
OK, too. Afterwards, the product structure must be opened once again.

As you can see, the codes of the symbols (B1, B2, V1) are transferred as item attributes. You decide which item
attributes to transfer.
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Thus, attributes are also available in BOM, which are created via HELiOS Report Manager. Click with RMB on the

article in HELiOS Product structure and activate Output to Report Manager .

By using the item attributes and dummy articles, you have the possibility to create BOM at a time when the final
specifications of articles are not fixed yet.

Attributes for product structure transfer from P + ID

The function Manage Plant Engineering Data in HELiOS of the program DBPlantDataImport.exe performs further
steps which prepare

n the use of dummy articles in P + ID

n the transfer of P + ID attributes into a HELiOS product structure
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Unlike the other modifications which Manage Plant Engineering Data in HELiOS makes, these are dependent on
the entries in the file attrcadhelios.dat stored in the HiCAD system directory.

This file generally determines which attributes are transferred to HELiOS when transferring a product structure. As
an example, the content may look as follows:

<TBDATE I_1>

@SOURCEPROG="hel i os"

@DOCFILENAME=""

@SOURCEDOC="CCadHel i osA t t r Kon f ig "

<COLUMNS>

@ATTR="HEL_CADSYSTEM",@TYP="STR ING ",

@ATTR="HEL_ATTRCAD ",@TYP="STR ING ",

@ATTR="HEL_ATTRHELIOS",@TYP="STR ING ",

@ATTR="HEL_H ICADTYPE",@TYP="STR ING ",

<DATA>

"h icad"; "%anzah l "; "HEL_ANZAHL"; "IN TEGER ";

"h icad"; "%menge1"; "MENGE1"; "DOUBLE";

"h icad"; "%posnr "; "POS ITIONSNUMMER"; "IN TEGER ";

"h icad"; "H ICAD_P ID_GERAET"; "P ID_GERAET"; "STR ING ";

"h icad"; "H ICAD_P ID_FUNKTION "; "P ID_ FUNCTION "; "STR ING ";

<DATAEND>

The entries on HICAD_PID_GERAET and HICAD_PID_FUNKTION are P + ID specific. The three entries above refer
to attributes which are generelly part of 2D parts.

Only in case if attrcadhelios.dat-file contains P + ID specific content, the modifications will be carried out as
described.

Modification 1: Create dummy article

Every part type is classified in HELiOS. For each of the plant engineering classifications one article master is cre-
ated, whose component type is(COMPONENT TYPE) a P + ID dummy article. The type identifier is K; the appro-
priate workflow is used.

The attribute Component type (COMPONENT_TYPE) will be extended to type P + ID dummy article accordingly.

Modification 2: Create additional item attributes

For each P + ID attribute, which should be transferred to a HELiOS product structure, an appropriate item attribute
must be available on the part of HELiOS. Because of a high amount of P + ID attributes, only those are being cre-
ated as item attributes which appear, as already mentioned, in attrcadhelios.dat.

For example, if attrcadhelios.dat contains the row
"hicad";"HICAD_PID_GERAET";"PID_GERAET";"STRING";

the item attribute PID_GERAET is created by type VARCHAR. The designation of the item attributes are freely
selectable. The type illustration is as follows:

STRING VARCHAR

What's new? 241 / 294

News Overview



INTEGER INTEGER

DOUBLE FLOAT

HICAD_PID_GERAET is one attribute key among many others which links to an P + ID attribute. In the Appendix
topic you will find lists with valid attribute keys.

When item attributes are being created, they are provided with language-depending labels. The texts are read with
the file fldlgcode.txt which can be found in AttDef-directory of PID/Libs-folder.

Summary

To prepare HELiOS for the transfer of the P + ID product structure including dummy articles, the following approach
is necessary:

1. Determine which P + ID attributes should be used as item attributes

2. Create entries in attrcadhelios.dat-file for the item attributes

3. OpenManage Plant Engineering Data in HELiOS from DBPlantDataImport.exe

A schematic presentation of the processes described in Step 3 can be found here.

Links from symbols to other sheets will be updated
If you change a sheet number, for example when inserting a new sheet between already existing ones, the link on
the discontinuation symbol will be changed automatically on this sheet.
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Adjustable sheet dialogue
In the Create sheet dialogue beneath Attributes with free values you can now specify 6 own attributes. For this pur-
pose the combo box contains attributes that can be used for title block symbols, but do not yet exist in the dialogue.
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The example below shows a selection of attributes from the combo box with specific values in the associated input
fields.
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This has the following effects on the symbol mask and the title block:

The contents of the attributes appear in the title block, since text points have been appropriately set for the chosen

attributes. You can set the text points with the Position dialogue text function (P+ID > Symbol > Edit...
>...). After calling the function, click on the title block. In the displayed list, choose the desired dialogue, e.g.
Reserve R01. Specify a fitting point in the title block.
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Direct access to the master data of a P+ID sheet
You have now the option to edit the master data of a P+ID sheet without having to call the Load sheet dialogue.
You have two options to open the master data dialogue:

n Via the context menu of a P+ID sheet (right-click on drawing frame)

n Via the pull-downmenu of the Process function in the P+ID Sheet function group.

In both cases the dialogue window for the editing of the P+ID sheet master data will be displayed.
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Utilisation of any HiCAD frame in P+ID
You can now use any HiCAD frame instead of the P+ID frames: To do this, activate the Use HiCAD frame check-
box on the P+ID drawing tab of the Settings dialogue:

Which HiCAD frames instead of the P+ID frames are to be used can be set in the Configuration Editor. There you
can also specify the text key representation in the HiCAD frames.

For each P+ID frame in DIN format you can find one entry in the configuration structure (Plant Engineering > P+ID
> DIN frame in P+ID):

Now you can enter the location of the frame that you want to use instead of the P+ID frame into the data record.

Also, please note that the ID of the text key representation (the assignment of the HiCAD attributes used in the title
block to the P+ID dialogue types) must be unique! These text key representations with their IDs can be found at
Plant Engineering > P+ID > Text key representation.
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To view and change the assignment, you need to display the list by clicking the ... button at Assignment > ....

The following syntax is used in the list: The string starts with the HiCAD attribute (text point key) of the HiCAD
frame, followed by a semicolon and the dialogue type of a P+ID attribute. The dialogue types for the P+ID attributes
cab be found in the List of Dialogue Types.

You have the option to generate and use your own text key representations (with a unique, unambiguous ID) accord-
ing to the above described syntax.

The HiCAD frames prepared in this way will behave like normal P+ID frames.
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Hide current paths
If desired you can suppress the representation of current paths in the P+ID. For this to happen, deactivate the Draw

current paths checkbox on the P+ID drawing tab of the Settings dialogue. This change will affect all sheets
of the project.
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Service Pack 2 2017 (V 2202)

IFC - Enhanced attribute mapping

For the configuration of IFC exports and imports with the Configuration Editor at Interfaces > IFC > Attribute map-
ping configuration you have now the option to assign individual mappings for each IFC type.

In the IFC object hierarchy you can find new nodes beneath Elements (IfcRoot objects) and Element types (IfcOb-
jectType objects).

The hierarchy level will be considered in the process; that is, for instance, a mapping for. "IfcElement.Name" will
affect all elements in the hierarchy beneath "IfcElement", a mapping for "IfcBeam.Name" will only affect
"IfcBeam".

NCX-Export - New setting options
The NCX Interface dialogue window now offers some new options.
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Maximum bore depth
This parameter enables you to separately define processings through two walls. To do this, you enter a distance
from which the processings are to be applied, e.g. from a beam thickness of 20mm 2 bores are to be created.

Comments
If you deactivate this checkbox, the output of comments in the lines of the NCX file will be suppressed. This can
make sense in particular cases, e.g. if the software used for the import of the files cannot read comments (e.g.
UNLINK).
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DSTV-NC interface - New options for letterings
When generating the NC data, the position of the lettering can now also be at the Bottom (Flange) and the Back
(Web). The dialogue window now offers additional options for this:

DSTV-BOM - Suppress output of bolts and screws
The dialogue window for the output of DSTV-BOMs contains the new Write S records checkbox.

This checkbox determines whether bolts and screws are to be output (activated) or not (deactivated).
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Update to CADfix 11 SP1
With the CADfix update to Version 11 Service Pack 1 the following format versions are available in HiCAD: NX 11,
Creo 4, SOLIDWORKS 2017.

Also, the export to the formats DXF and DWG has been speeded up significantly for large files.

IFC export: Transfer part structure
For IFC exports you can ensure by activating the Transfer part structure option that the hierarchy of the part struc-
ture will be preserved. If the option is deactivated, the structure will be broken up.

Only export visible parts (for CADfix formats)

You can now activate the Export displayed parts only to export only parts that are visible in the active HiCAD view.
With the release of Service Pack 1 this option has been integrated in all CADfix formats. These comprise STEP,
AutoCAD (*.dxf und *.dwg), IGES, VDAFS, CatiaV4 and CatiaV5, ACIS, Parasolid, ProE, JT and PLMXML.
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NCX export of unconnected multi-part beams (via HiCAD or HELiOS Spooler)
For NCX exports you have now the option to treat itemized, unconnected multi-part beams as one single part when
generating the NCW files.

For this to happen, you need to activate the Output itemized series beams as one part option at the bottom of the
dialogue window.

The export to the NCX format can now also be performed via the HELiOS Spooler.
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3-D DXF/DWG: Import texts
When importing 3-D files from AutoCAD (DXF, DWG) you can activate the Take texts frommodel checkbox to trans-
fer the annotations of the AutoCAD model to HiCAD.

The texts will be imported as part annotations with leader line. Before the import, their appearance can be influ-
enced via the annotation settings for texts with leader lines in the file ...\sys\DXF_Importtext.ftd (choose 3-D Dimen-
sioning + Text > Text > Part annotation, with free text and leader line).
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DXF: Export sheet developments
Due to the switch to the new 3-D development (Version 2000), the current development parameters of the model
drawing will be used when performing exports with the DXF - Complete functions.

The development parameters, e.g.

n Powder marking lines

n Bend lines

n Bend zones

n Bend radii

n Tooling info

n Dimensioning

n Processing direction symbols

can be specified with the Default setting function (Sheet Metal > Sheet development > Update > ...).

Further information about sheet developments as DXF export can be found in the Online Help of the Sheet Metal
module.

Parts4cad / BimCatalogs
The updating of manufacturer catalogues has been made easier. Clicking the Refresh button in the dialogue win-
dow removes old manufacturers and adds new ones in all catalogues in less than one minute.

Catalogues of particular manufacturers can be updated with the corresponding context menu function, which also
takes less than one minute).
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Update to CADfix 11
With the update to CADfix 11 the following format versions will be available in HiCAD: CATIA V5 2016 (R26),
SOLIDWORKS 2016, ACIS R26 (2016.0.1) and

Parasolid 28.0.

Access to BIMcatalogs.net by CADENAS
Access to 3-D BIM CAD models is now even easier. If you have Internet access, the product catalogue BIM cata-
logs.net by CADENASPartSolutions will be available to you. To access the catalogue, open the Drawing tab and

choose Insert Part > Exp. > BIMcatalogs .

In this way, 3-D BIM CAD models can be conveniently imported to HiCAD by Drag & Drop, where they can then be
processed further. The easy, intuitive operation spares you a lot of time that would otherwise be spent on searching
for the right model, and increases the productivity of your Engineering department.
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Direct call of eluCad from HiCAD

Use the eluCad function to transfer parts directly to the EluCad software.

The transfer takes place externally via export of the parts to the NCX format. The restrictions of the NCX format
apply here, too: An export of assemblies is not possible and only BOM-relevant parts will be exported. Other export
settings will be the default values of the NCX interface.

The installation of eluCad will be found in the system automatically, no configuration will be required.

3DVS export for Kisters 3DViewStation
The 3D ViewStation Desktop of the Viewer provider KISTERS is a universal 3D-CAD viewer for native formats. Files
from different CAD applications can be converted into common 3-D and 2-D formats (3D-PDF, IGES, JTOpen, 2D-
PDF) and visualized in the 3DViewStation.

With HiCAD 2017 you can export drawings to the 3DVS format and exchange them for viewing purposes.
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Also, a direct integration of the HiCAD file format (SZA and KRA) into the 3DViewStation has been achieved in
cooperation with KISTERS.
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NCX: Output series beams as one part
If you have activated the NCX export option Output itemized series beams as one part at the bottom of the dia-
logue window, series beams that have been subordinated to the assembly will not be exported as individual parts,
but as one part, provided that an item number has been assigned.

IFC import without feature data
For the import of IFC files you can deactivate the Create feature checkbox if you do not want to save the feature
data after creation of the part in HiCAD. During IFC export, parts are generated via feature calculation. After cre-
ation of the part the feature data will be discarded if this option has been deactivated beforehand. This can be use-
ful in large drawings, where the feature data may decrease the overall performance.
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DSTV-NC export - Now with Favourites Management

The settings for DSTV export can now be saved as Favourites and re-used at any time. To do this, click the
icon at the bottom left of the window. The Favourites for DSTV-NC export will be saved as XML files to the directory
Configuration\Favourites\SteelEngineering\DSTV-NC of your HiCAD installation.

Favourites are saved to the same-named sub-folder of the directory in which the HiCAD Configuration database is
also located. If you have installed HiCAD from the red DVD with the ISD default settings, this will be the folder Pro-
gramData\ISD Software und Systeme\HiCAD nnnn, with nnnn being the HiCAD version, e.g. 2017.

More on Favourites Management can be found in the Manage Favourites topic of HiCAD Basics Help.

STEP export: Powder marking line output and fits information
Powder marking lines are now output by default in the STEP export. If you do not want this, you can deactivate this
behaviour.

Furthermore, you can activate or deactivate the output of fits information via surface colour via a checkbox in the
dialogue window. On the exported STEP part the diameter of the corresponding bore will be highlighted.
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HELiOS Desktop

Service Pack 2 (V 2202)

Displaying of attributes of linked objects in masks and result lists
Various enhancements of the HELiOS Deskop allow an easy displaying of attributes of linked objects in masks or
result lists.

The New Articles and Documents tab (combined) result list can be added to the UI in the Project or Folder
Explorer and contains an overview of the attributes of linked articles and documents in one row.

Two new virtual attributes of the result list configuration show the project and folder assignments of objects in art-
icle or document result lists.
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The Mask Editor now offers the option to create article data fields in document masks and document data fields in
article masks, in order to show attributes of linked objects in (detail) masks.
This can be done with the context menu function New article data field (for document masks) or New document
data field (for article masks), respectively.

Result list button for opening of documents
To speed up access to documents, HELiOS now offers the option to assign document result lists of the Project
Explorer or Folder Explorer context to buttons which allow an opening of documents with one click - either for edit-
ing or in read-only mode - in the linked application.

For this purpose, the two attributes UI_OpenEditItem and UI_OpenItemReadOnly have been created, which
simply need to be activated in the result list configuration.
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Revised Serial document input dialogue window
The Serial input function for documents has been redesigned and expanded.

Besides project selection you can now also assign folders and workflows directly via the settings of the dialogue win-
dows.

You can specify via checkboxes whether imported source files are to be preserved or deleted in their original loc-
ation. You can also specify whether the document data input mask is to be called for each individual file, or whether
the serial input is to be done automatically without the mask.
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The Configuration for attribute initialization can be expanded by the user, allowing him/her to select various con-
figurations from the pull-down menu. In this way, recurring initialization patterns can be assigned with a few mouse
clicks, avoiding manual definitions.

If ZIP files are to be added to HELiOS via serial document input, the input dialogue will provide an additional section
for this purpose:

Expanded HELiOS-URLs
When using the HELiOS URL for object types, folders, user-defined types (materials, customers) and pipe classes
are now also supported.
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HELiOS Options: Avoid unwanted printing of notes documents
In some cases youmay not want documents with created or accepted notes documents to be printed.

For such cases a new option has been added on the Print tab of theHELiOS Options dialogue window:

The corresponding documents in the Print dialogue will be marked as such, are excluded from printing, and will only
be printed after their explicit selection.
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Use of articles: Filter options and increased performance
The result lists for the use of parts or assemblies (parts where-used lists) can now be further refined by means of
user-defined filters.

This allows you, for instance, to save search templates that will show you in which currently released assemblies a
particular part with a particular index is directly or indirectly contained, or in which pre-mounted facade parts a par-
ticular sealing element has been used throughout different projects.

As is the case with the combined search, article classes and links can be considered. The latter is, for instance, rel-
evant for a filtering for mechatronical items inmechanical engineering or electrical engineering BOMs, since mech-
anical engineering article are normally linked to a CAD document.

Also, a performance increase could be achieved here.
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Favourites: Displayed index

If you click on the Show objects symbol in the Favourites window, the Displayed object state dialogue window
will be displayed. Here you can choose whether the objects in the Favourites window are to be displayed with the
index with which they had been added, or with their highest index (if any).

Generate item numbers
The Generate item numbers function in the context menu for items of the product structure allows you to create
item numbers for multiple selections of objects, with the option to specify a start value and an increment for this
value.

This procedure replaces the one used in connection with the "Product Editor" of older HELiOS versions.
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Restore notes documents
The range of functions for Notes documents has been expanded by the option to restore rejected notes documents
again.

In this way, changes can be applied to the first rejected and then accepted notes document without having to cre-
ate a new notes document to be accepted.
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Print documents
The new Print dialogue window for Documents enables you to send print jobs for Documents from (also multiple
selections) from one central and configurable dialogue:

In the process you can specify which documents are to be printed and which context (Article, Folder, Project) is to
be relevant for the filling in of the title block.
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A multitude of individual steps that would otherwise be required for the printing process can thus be done in one go.
For instance, you have the option to directly print documents that are linked to a selected article:

The exact behaviour of the dialogue depends on the settings specified on the Print tab of the HELiOS Options dia-
logue window.

What's new? 271 / 294

News Overview



Print result lists
The function for the printing of result lists from the HELiOS Desktop via the Report Manager has been improved.

In the process, all attributes will be considered which have been assigned on the Report tab of the corresponding
result list (configuration).

While attributes that are only shown in the result list of the are listed according to the print job, "hidden" attributes
can be subsequently added in the Report Manager if desired.

In this way, "detours" via older template files can be avoided, which have therefore been removed from the system.
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New Folder and Project selection dialogues
On the left hand side of the Folder and Project selection window you can now find three new tabs that allow you to
assign Articles or Documents to Projects or Folders, as well as the assigning of Projects or Folders within their cor-
responding Project or Folder structures.

The Structure tabs show the hierarchical structure of the Projects or Folders, as shown in the corresponding
Explorer.

If you click on the Find tab, the already Project or Folder search mask will be displayed. Here you can enter spe-
cific search criteria and choose an object by double-clicking the corresponding entry in the result list.

The List tab shows an alphabetical list of all Projects or Folders (without any hierarchical dependencies).

Please note:

This new feature replaces the setting options for the list form and structure of Projects and Folders on the Display
tab of the HELiOS Options.
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Indication of new indices in structure versions
In the Product structure versions dialogue window, a yellow star symbol indicates whether there are indices for
structure items at Temporary / Highest Index in the database that are newer than the ones that are shown in the
currently displayed structure.

Result list configuration
Besides the generally increased performance for result list configuration, some new options are now available:

In the window for result list configuration ("Adjust result list...") you can now load all result list representations cre-
ated by the user with one mouse click via the Result list display pull-downmenu and configure them in the window.
It is no longer necessary to take the intermediate step via "Manage..." .

You can use Drag & Drop to change the position of elements in result lists. When dragging columns, HiCAD will
automatically scroll horizontally in the process.

Also, you can specify whether the attributes are to appear in centred, right aligned or left aligned position in the cell
of their result list row.

Result list options
The new input field Number of data records up to which the content is moved when scrolling on the Result list
tab of the HELiOS Options dialogue window allows you to specify how many result list entries are to be moved dur-
ing scrolling. If the limit is reached, new displayed result list rows will be called in a "frozen" state.
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This setting options makes sense as a "fluent" scrolling can be very performance-intensive in very long result lists.
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Also, the Attribute selection dialogue window for the specification of sort sequences in result lists has been
revised.
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Export and Import of settings
Individual settings of the HELiOS UI can be conveniently distributed among other users and workstations by select-
ing View > Settings > Export.

In the following selection dialogue you can specify for which UI areas the settings are to be exported:

After confirming with OK a .zip file containing all relevant system files will be stored.

Via Settings > Import this .zip file can be loaded on all other HELiOS workstations and thus be used as the new
default UI configuration.

You can also specify during import in the dialogue for which UI areas the settings are to apply, and select only par-
ticular elements from a "complete package". For instance, you can import Favourites from one workstation or user
without changing your result list settings or window arrangements.
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Furthermore, you have the option to import UI configurations when installing the HELiOS Desktop. In the Extended
settings dialogue window of the installationmask you can import a UI configuration:

Display of notes documents in result lists
If you work with notes documents, the status of an existing notes document will be indicated in the document result
list via the attribute Redline (VA_DocumentHasAnnotation) by means of an icon.

Possible icons are:

n A notes document exists for the document.

n The notes document linked to the document has been accepted.

n The notes document linked to the document has been rejected.
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New option for linked articles on 'Display' tab
On the Display tab of the HELiOS Options dialogue window you can now specify by activating or deactivating the
Detect linked articles for preview of documents checkbox whether for the graphic preview of a document the list
of all linked documents is to be loaded by default. Since this loading behaviour is very performance-intensive, you
have the option to switch it off. In this case an article-independent graphic will be displayed.

Notes on license configuration of ERP interfaces
If you use HELiOS in conjunction with ERP interfaces, please note the following change:

n The license module "PPS Interface" has been renamed to ERP Connect".

n The module "PPS Special" is no longer available.
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HELiOS in HiCAD

Service Pack 2 (V 2202) 

Loading of HiCAD drawings from HELiOS dialogue windows
In older versions a direct loading of documents from HELiOS dialogue windows into HiCAD via the context menu
function Open + Edit was not possible.

In such cases an error message was displayed, saying that the action is not possible.

From HELiOS 2017 Service Pack 2 onwards this action can be carried out without any problems.

If any modal HELiOS dialogues are still open, blocking the opening of documents, a message will be shown, asking
you whether these dialogues should be closed to enable the opening of the documents:
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Service Pack 1 2017 (V 2201) 

NCW export
From Service Pack 1 onwards, a conversion of CAD parts to the NCW format via the HELiOS Spooler will be pos-
sible.

A new installation of HELiOS will automatically provide this option. For an update installation to SP1, a
manual adding of the corresponding entry in the system file Hel_fileconvert.ini may be required (see also Notes on
Conversion of .SZA Files via the Spooler.
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Marking of newer indices in the product structure
When transferring the product structure to HELiOS, or when displaying the Product structure versions dialogue,
newer indices will be marked with a yellow star-shaped symbol.
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Load with index selection
When loading Documents and Articles via the Combined search dialogue you have now the option to activate the
Load, with index selection checkbox.

If older indices exist for a selected document, they will then also be loaded into HiCAD via the following dialogue
window.
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Performance
For standard parts transfer from the HiCAD catalogue to HELiOS a performance increase of up to 25% could be
achieved.

The performance for the filling in of title blocks in drawing frames with HELiOS data has also been increased.

284 / 294 What's new?

HELiOS in HiCAD



New data format - Conversion required for updates
HiCAD 2017 comes with the new 2-D figures archive with the file name extension .FGA. Please use only this new
.FGA format. For the conversion of existing 2-D FIG files you can use the Converter_FIG_To_FGA.exe tool in the
HiCAD\exe directory. You can also install this converter form the installation DVD.

When you perform an update to HiCAD 2017, the 2-D parts that are supplied with HiCAD by default (e.g. drawing
frames) will be switched from FIG to FGA in different locations of the installation directory. Before their conversion,
the data are saved in their original state in a folder or ZIP archive, respectively, to the "Szenen" and "Kataloge" dir-
ectories. A LOG file in each directory records all converted files.

When you create an interface between HiCAD 2017 and HELiOS you will be prompted after a new or an update
installation to adjust the database accordingly. The search for and management of 2-D parts will only be possible
after a successful adjustment of the database and the conversion of the existing FIG files.

If you manage the HiCAD files in HELiOS, the following message will appear when you start HiDAD for the first time
after a new or update installation of HiCAD 2017:

Click Yes to start the conversion of data in the database. This means that the linked 2-D part name contained in the
data set will be changed from *.FIG to *.FGA. The database will then only search for FGA files. Therefore, the 2-D
parts now need to be converted to FGA files by means of the Converter_FIG_To_FGA.exe tool.

If you have installed HiCAD 2017 for test purposes, you need to click No here. Older versions (before HiCAD 2017)
cannot load FGA files. Please note that the database adjustment cannot be revoked!
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HELiOS Spooler

Service Pack 2 (V 2202)

Support of multiple identical printer drivers
From HELiOS 2017 Service Pack 2 onwards you can install multiple ISD FilePrinters on the same system.

This allows an easy selection of different receivers and postprocessing of print jobs, without having to choose print-
ers and postprocessings separately.

Conversions for SOLIDWORKS, AutoCAD and Inventor
From HELiOS 2017 Service Pack 2 onwards the HELiOS Spooler supports direct conversions from
SOLIDWORKS, AutoCAD and Inventor into formats such as DXF, DWG, STEP and 3DPDF.

In AutoCAD the configuration file format PC3 (DevMode) is supported and, in Inventor, the creation of DXF files for
Sheet Metal parts via the Spooler.
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Service Pack 1 (V 2201)

HELiOS Spooler Admin Tool: Job statuses
If any print or conversion jobs that have been sent to the HELiOS Spooler cannot be processed, another attempt will
be started half an hour later. The concerned jobs will first obtain the status Failed and will then be set to Retry:

NCW export
From Service Pack 1 onwards, a conversion of CAD parts to the NCW format via the HELiOS Spooler will be pos-
sible.

Please note:

A new installation of HELiOS will automatically provide this option. For an update installation to SP1, a manual
adding of the corresponding entry in the system file Hel_fileconvert.ini may be required (see also Notes on Con-
version of .SZA Files via the Spooler.

The conversion to the NCX format is only possible for itemized Steel Engineering parts.
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HELiOS PrintClient: New options
The HELiOS PrintClient now offers two additional setting options that allow to sent print jobs multiple times or send
them as batches:

n Remove jobs after sending

If this checkbox has been activated (default setting), print jobs will be deleted from the list after their sending
and processing. Deactivate this checkbox if you want print jobs to remain in the list after their sending and pro-
cessing. This allows you to repeat the print job directly in the PrintClient dialogue window.

n Send jobs as batch

If this checkbox has been activated, series of print jobs sent from your Client will be sent and processed as a
batch, without interfering with print jobs of other Clients.
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Major Release 2017 (V 2200)

Server settings
The Server settings of the HELiOS Spooler Admin Tools have new options that allow you to define how to proceed
with the deletion of done print jobs from the system.

Other export formats
The following formats can now be exported via the Spooler: 3dvs, VRML, U3D und STL.
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HELiOS MS Office Interface

Major Release 2017 (V 2200)

Edit Documents
If a read-only document has been opened in an Office application, you can click Edit to set it to an "In progress"
state. In this state the document will be locked against editing by other users.

Support of external references in Excel
The HELiOS-MS Excel interface now also supports external references.

If an Excel document contains references to external files, these can be recognized by HELiOS and the structure
can be taken over accordingly.
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HELiOS Vault Server

Service Pack 1 (V.2201) 

Enhanced replication options with VSKonfig.exe
If you are using a network of several Vault Servers exchanging replicated files, one of them must be defined as the
central Vault, and the other ones as secondary Vaults.

For this purpose the VSKonfig.exe tool now contains the additional options: In the Replication mode pull-down
menu on the Remote Servers tab you can define a Vault as Central Vault or Secondary Location, and specify
whether no replication is to be performed or an attribute-controlled one.
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